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RÉSUMÉ 

Robillard, A., Lévesque, D. et Roux, M.-J. 2024. Méthodes complémentaires d'imagerie sous-
marine déposée pour la collecte de données biologiques et environnementales. Volume 2 : 
Procédures d’analyses photo et vidéo. Rapp. tech. can. sci. halieut. aquat. 3605 : x + 95 p. 
 
L’échantillonnage visuel permet la collecte de données biologiques et écologiques dans 

l’environnement marin, de manière peu intrusive et non-extractive. Les dispositifs d’imagerie 

déposés sont des systèmes polyvalents et faciles d’emploi pouvant être déployés dans différents 

milieux et permettre l’acquisition d’une grande quantité d’images. L’extraction des données sur 

les échantillons visuels récoltées lors des analyses d’imagerie représente un processus onéreux 

en temps et en expertise qui nécessite des procédures standardisées et interopérables. Ce 

rapport a pour objectif de contribuer au développement et à l’optimisation de procédures 

standardisées d’analyses d’échantillons photo et vidéo provenant de systèmes déposés, incluant 

l’usage d’un quadrat, d’un appât, et de la stéréoscopie. Un ensemble de pratiques, méthodes, et 

stratégies d’analyses sont présentées permettant de i) maximiser la qualité, la quantité, et la 

diversité des données récoltées; ii) de tenir compte des facteurs méthodologiques, écologiques, 

et environnementaux influençant la performance des dispositifs d’échantillonnage et la précision 

des données d’imagerie; et iii) de générer des données fiables accompagnées d’erreurs 

quantifiables. Ces procédures sont applicables à la plupart des environnements marins et 

échantillons photo ou vidéo issus de systèmes déposés. Leur application permettra d’augmenter 

la contribution de l’imagerie sous-marine à la gestion écosystémique des milieux marins.  

  



x 
 

ABSTRACT 

Robillard, A., Lévesque, D. et Roux, M.-J. 2024. Méthodes complémentaires d'imagerie sous-
marine déposée pour la collecte de données biologiques et environnementales. Volume 2 : 
Procédures d’analyses photo et vidéo . Rapp. tech. can. sci. halieut. aquat. 3605 : x + 95 p. 
 
Visual sampling allows for the collection of biological and ecological data in the marine 
environment in a minimally intrusive and non-extractive manner. Deposited imaging systems are 
versatile, easy-to-use, and can be deployed in different environments, enabling the acquisition of 
a large quantity of images. Extracting data from visual samples using imaging analyses is a time-
consuming and expertise-demanding process, requiring standardized and interoperable 
procedures. This report aims to contribute to the development and optimization of standardized 
procedures for photo and video analyses from deposited systems, including the use of a quadrat, 
baits, and stereoscopy. A set of practices, methods, and analytical strategies are presented to i) 
maximize the quality, quantity, and diversity of collected data; ii) consider methodological, 
ecological, and environmental factors influencing the performance of sampling devices and the 
precision of imaging data; and iii) generate reliable data with quantifiable errors. These 
procedures are applicable to most marine environments and photo or video samples from 
deposited systems. Their implementation will serve to increase the contribution of underwater 
imaging to ecosystem-based management of marine environments. 
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1. INTRODUCTION 

Les méthodes d’échantillonnage visuel en milieu marin font désormais partie de la boîte à outils 

des biologistes et des écologistes en sciences aquatiques et halieutiques. Ces méthodes non-

extractives permettent notamment d’échantillonner des habitats marins difficilement accessibles 

aux méthodes conventionnelles, et de minimiser l’impact de la collecte de données biologiques 

sur les écosystèmes (Bowden et al. 2020; McGeady et al. 2023). Cependant, le plein potentiel 

des méthodes d’imagerie sous-marine est limité par le temps et les ressources nécessaires afin 

de mettre en œuvre un ensemble de bonnes pratiques dans la préparation des fichiers pour les 

analyses d’images et l’extraction des données biologiques et écologiques. Les procédures 

utilisées pour l’organisation des fichiers, l’annotation des images, l’identification taxonomique, le 

dénombrement et les mesures des organismes influencent la quantité, la qualité et le type de 

données récoltées (Jones et al. 2021a; Perkins et al. 2022). Les méthodes doivent être 

cohérentes et standardisées afin d’assurer la qualité et la comparabilité des données recueillies 

(Murphy et Jenkins 2010; Whitmarsh et al. 2017). Diverses approches et paramètres standards 

ont vu le jour au cours des dernières décennies, la plupart visant l’atteinte d’objectifs spécifiques 

à l’intérieur de contextes précis (e.g., Santana-Garcon et al. 2014; Harvey et al. 2021).  

Scallon-Chouinard et al. (2022) présentent deux systèmes d’imagerie déposés utilisés pour la 

collecte d’échantillons photo et vidéo : un système de caméras photo déposé (CPD) avec 

quadrat, et un système de caméras vidéo stéréoscopiques appâté (CVSA). Ces deux systèmes 

d’échantillonnage visuel peuvent être appliqués dans de nombreux habitats (ex. substrat 

rocheux), sont faciles à manipuler étant relativement légers et stables, et permettent l’acquisition 

d’images « haute résolution » à faible coût. Ces dispositifs d’échantillonnage fixes peuvent être 

déployés de manière indépendante ou complémentaire lors de relevés scientifiques ou d’activités 

commerciales en mer. Ils permettent l’acquisition d’une grande quantité d’images qui peuvent 

être traitées et analysées à l’aide de logiciels (ou plateformes) d’analyse spécialisés facilitant 

l’identification et l’annotation de spécimens (Zurowietz et Nattkemper 2021), et la prise de mesure 

sur les organismes et les composantes de l’habitat observés (Harvey et al. 2002; López-Macías 

et al. 2023). 

Les systèmes de type CPD permettent d’étudier les habitats et invertébrés ou autres organismes 

benthiques peu ou pas mobiles, incluant la végétation aquatique submergée (Kohler et Gill 2006; 

Larocque et Thorne 2012; Trygonis et Sini 2012; Tuck et al. 2015; Kahn et al. 2020; Terrill 2021). 

Différentes méthodes d’annotation sont disponibles pour l’analyse d’échantillons photo. Pour les 

organismes benthiques non-coloniaux, la méthode de dénombrement par unité de surface, 

incluant l’annotation par point, peut être utilisée (ex. Larocque et Thorne 2012; Tuck et al. 2015). 

Selon le plan d’échantillonnage, les organismes coloniaux peuvent être annotés en termes 

d’occurrence, ou de couverture de surface (Perkins et al. 2022). L’estimation du pourcentage de 

couverture des organismes coloniaux et des types de substrats peut être réalisée par le décompte 

de cellules d’un damier (Trygonis et Sini 2012), l’échantillonnage aléatoire ou stratifié d’une grille 

de points (Kohler et Gill 2006; Larocque et Thorne 2012; Terrill 2021), ainsi qu’en mesurant la 

surface de couverture à l’aide de polygones tracés (Kahn et al. 2020). L'emploi de méthodes de 

mesures en 2D, réalisé en convertissant la taille d’un pixel d’une photo à une mesure en se basant 

sur la taille d’un objet connu, permet de déterminer la taille de certains organismes (Stokesbury 

et al. 2014). Ces mesures peuvent être utilisées pour estimer des biomasses en se basant sur 

relations taille-masse déjà établies ou des structures de taille populationnelle.  
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Les systèmes appâtés tel le CVSA sont utilisés pour l’étude des populations de poissons et autres 

organismes mobiles (Whitmarsh et al. 2017; Langlois et al. 2020). Les procédures d’analyse vidéo 

visent généralement le dénombrement et l’estimation d’abondance des organismes. La méthode 

préconisée pour ce faire est celle du MaxN, correspondant au suivi du nombre maximal 

d’individus d’un même taxon présents et visibles à l’intérieur du champ d’analyse à un moment 

donné de la période d’analyse définie pour l’échantillon vidéo (Langlois et al. 2020). Le MaxN est 

un paramètre conservateur permettant d’estimer l’abondance relative des espèces observées en 

minimisant la pseudoréplication, c’est-à-dire l’éventualité d’un comptage répétitif d’un même 

organisme à l’intérieur d’un même échantillon (Whitmarsh et al. 2017; Langlois et al. 2020). 

D’autres procédures d’analyses visent à quantifier la densité des organismes sur le site 

d’échantillonnage via le calcul de paramètres tels que le temps de première apparition (T1) 

(Stobart et al. 2015; Devine et al. 2018), le décompte moyen ou MeanCount (Schobernd et al. 

2014), et le MaxN cumulatif, lequel permet d’effectuer un suivi de l’abondance des espèces et 

organismes dans le temps (Santana-Garcon et al. 2014). Plusieurs études ont évalué l’utilité 

respective et la correspondance entre ces différents paramètres (Cappo et al. 2006; Campbell et 

al. 2015). L’usage de la stéréoscopie, laquelle consiste en un échantillonnage simultané avec 

deux caméras en position fixes et précalibrées, permet de mesurer efficacement les organismes 

mobiles et quantifier la précision des mesures (Harvey et al. 2010). Ceci représente un aspect 

avantageux pour l’étude de la structure de taille des populations et communautés marines. La 

stéréoscopie permet également d’effectuer des mesures précises à partir de points 3D sur 

diverses composantes du substrat. Ces informations peuvent être utilisées pour caractériser 

l’habitat benthique de manière standardisée via une approche semi-quantitative ou quantitative 

(Collins et al. 2017; Przeslawski et Foster 2020). 

Ce rapport a pour objectif de détailler un ensemble de bonnes pratiques, méthodes, et stratégies 

d’analyses d’images permettant de i) maximiser le potentiel d’extraction des données biologiques 

et écologiques disponibles dans les échantillons photo et vidéo en termes de quantité, de qualité 

et de diversité; ii) de tenir compte des facteurs méthodologiques, écologiques, et 

environnementaux ayant une incidence sur les données récoltées; et iii) de générer des données 

fiables et comparables accompagnées d’erreurs quantifiables. Il présente des procédures 

opérationnelles pour l’analyse d’échantillons photo et vidéo issus des systèmes CPD et CVSA. 

Ces procédures sont applicables à tous les échantillons photo ou vidéo issus de divers dispositifs 

d’imagerie sous-marine déposés. Leur mise en pratique permettra d’augmenter la contribution de 

l’imagerie sous-marine à la gestion écosystémique des ressources et habitats marins.   
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2. ACQUISITION ET GESTION DES IMAGES 

2.1. ORGANISATION ET NOMENCLATURE DES FICHIERS 

L’échantillonnage visuel en milieu marin génère une grande quantité de fichiers d’imagerie, ce 

qui représente un défi d’archivage et de stockage. Cette section propose quelques techniques 

visant à faciliter la gestion des échantillons photo et vidéo, depuis leur acquisition sur le terrain 

jusqu’à leur traitement avec différents logiciels d’analyses d’imagerie.  

Les systèmes avec des appareils choisis pour faire de l’imagerie déposée tels que le CPD et le 

CVSA, ont l’avantage d’être abordables, polyvalents et faciles à utiliser, et le désavantage d’avoir 

une capacité de stockage intégrée relativement limitée (Scallon-Chouinard et al. 2022). Il est 

nécessaire de procéder régulièrement au téléchargement des cartes mémoires et à la 

sauvegarde des fichiers photo et vidéo au cours des campagnes d’échantillonnage afin de libérer 

l’espace de stockage et de sécuriser les échantillons d’imagerie. Dans ce contexte, une approche 

utile, rapide et efficace consiste à effectuer la sauvegarde des images dans des dossiers distincts, 

identifiés selon la date en format standardisé, le système d’échantillonnage utilisé (ex. CVSA ou 

CPD) et le code identifiant la caméra (pour les systèmes équipés de caméras multiples). Cette 

approche permet de classer efficacement avec des identifiants unique les fichiers d’images 

récoltés sur le terrain pour un traitement ultérieur.  

Chaque déploiement de systèmes d’imagerie correspond à une unité d’échantillonnage à laquelle 

est associé un nombre variable de photos ou de séquences vidéo. Afin d’assurer la traçabilité 

des images récoltées et des données, il est nécessaire de générer un identifiant unique/code 

d’opération (OpCode) permettant d’associer chaque photo et segment vidéo à un déploiement. 

Une nomenclature fondée sur les métadonnées est recommandée pour générer l’OpCode. Les 

métadonnées comprennent notamment des informations relatives au projet de recherche (ex. 

numéro de mission en mer), aux sites échantillonnés (ex. numéro de station, coordonnées 

géographiques), au système d’échantillonnage utilisé (ex. code d’engin), ainsi qu’aux 

coordonnées temporelles et succès de l’échantillonnage (ex. heure de début/fin, durée et cote de 

résultat). L’utilisation des métadonnées de terrain pour générer un identifiant unique à chaque 

déploiement, et ultimement à chaque image, a l’avantage d’augmenter la traçabilité des images, 

notamment lors du partage en ligne sur des plateformes telle OBIS (Ocean Biodiversity 

Information System), et représente un pas de plus vers l’application des principes des données 

FAIR (Faciles à trouver, Accessibles, Interopérables et Réutilisables) (Wilkinson et al. 2016). Un 

exemple d’identifiant unique (OpCode), utilisé pour distinguer les déploiements CPD et CVSA, 

est présenté au Tableau 1.  

Les dossiers pour archiver les échantillons devraient être structurés de manière à faciliter la 

nomenclature et l’accès aux fichiers. Les images devraient être regroupées par déploiement. 

Chaque fichier photo et vidéo devrait être renommé selon l’identifiant unique du déploiement (ex. 

OpCode), l’identifiant de la caméra (ex. C1_D) et un numéro séquentiel (ex. 01), en suffixe ou en 

préfixe (ex. Annexe 1 Figure A1.1 pour le CPD et Annexe 2 Figure A2.1 pour le CVSA). Des 

logiciels simples et flexibles peuvent être utilisés afin d’optimiser le processus de renommage des 

échantillons d’imagerie (ex. Bulk rename utility).  

La sauvegarde des fichiers pour les analyses et l’archivage est une étape cruciale qui peut être 

effectuée sur des disques durs, des serveurs locaux ou des services d’entreposage en ligne 

(espace infonuagique), selon les besoins, les coûts et les infrastructures. Ces deux dernières 

https://www.statcan.gc.ca/fr/afc/litteratie-donnees/catalogue/892000062022002
https://www.statcan.gc.ca/fr/afc/litteratie-donnees/catalogue/892000062022002
https://www.bulkrenameutility.co.uk/
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méthodes ont l’avantage de permettre simultanément l’accès aux échantillons à de multiples 

analystes. 

 
Tableau 1. Métadonnées et nomenclature suggérées pour créer un identifiant unique (OpCode) 

servant à classifier et archiver les échantillons visuels récoltés lors de déploiements de systèmes 

d’imagerie sous-marine CPD et/ou CVSA. Note : Les lettres RE représentent un code d’équipe 

(utile lorsque des engins similaires appartenant à différentes équipes de recherche sont employés 

simultanément) 

Variable Description Exemple 

Mission Numéro de la mission en mer (3 chiffres) 025 

Station Numéro ou nom de la station (3 chiffres) 045 

Réplicat Numéro de réplicat lorsque des dépôts 
multiples sont effectués sur une même station 
(2 chiffres) 

01 

Date Date du déploiement en temps universel 

coordonné (aaaammjj [UTC]) 
20220702 

Heure  Heure de début du déploiement en temps 
universel coordonné (hhmm [UTC]) 

1603 

Engin Code de l’engin (lorsque plusieurs systèmes 
similaires sont utilisés) 

RE1 

Exemple 
OpCode 
(CPD) 

Code d’opération du déploiement CPD 
(Mission_Station_Réplica_Date_Heure) 

025_045_01_2022070
2_1603* 

Exemple 
OpCode 
(CVSA) 

Code d’opération du déploiement CVSA 
(Mission_Station_Réplica_Date_CodeEngin) 

025_045_01_2022070
2_RE1 

*L’OpCode suggéré diffère de celui utilisé ailleurs dans ce rapport.  

2.2. VISIONNEMENT PRÉLIMINAIRE ET ÉVALUATION DE LA QUALITÉ 

DES ÉCHANTILLONS 

Un visionnement préliminaire est recommandé afin d’évaluer la qualité des échantillons 

d’imagerie et la quantité relative d’informations biologiques et écologiques qui pourront être 

extraites au cours des analyses. Cette étape, réalisé avant le début de l’analyse, permet de 

prioriser efficacement le traitement des échantillons photo et vidéo et à déterminer leur utilité en 

fonction des objectifs de l’étude. L’évaluation qualitative des échantillons constitue une bonne 

pratique qui servira également à l’interprétation des données. 

Échantillons photo en séquence 

Le système CPD est utilisé pour acquérir des échantillons de séquences photo en mode intervalle 

de temps (Scallon-Chouinard et al. 2022). Chaque séquence photo produite par chacune des 

deux caméras du CPD, soit la caméra en vue verticale du quadrat et la caméra en vue oblique, 

doit être évaluée en termes de qualité visuelle (voir procédure 1.2 en Annexe 1). Cette étape 

consiste à sélectionner la photo pour chacune des vues/caméras présentant la meilleure qualité 

visuelle, incluant la photo principale sélectionnée pour les annotations. Une cote de visibilité, avec 

six niveaux, allant de 0 (nulle) à 5 (excellente) est d’abord attribuée à chaque photo sélectionnée, 

en se basant sur une méthode adaptée de Jones et al. (2021b) et du système de notation 0 à 5 
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étoiles (Tableau 2 et Figure 1). Ensuite, une cote de qualité doit être attribuée à chaque 

déploiement CPD, à partir de la cote de visibilité, en intégrant les informations sur le nombre de 

photos appariées analysables et les problèmes liés au champ visuel rencontrés (ou non) lors de 

l’échantillonnage (Tableau 3). Les détails du calcul de la cote de qualité des séquences proposée 

sont expliqués dans la procédure 1.2 de l’Annexe 1. 

Tableau 2 : Cote de visibilité utilisée pour évaluer la qualité des photos (en termes de clarté de 

l’eau et de résolution) produites par le CPD, incluant les caméras en vue verticale et oblique 

(Adapté de Jones et al. 2021b). 

Cote  Description 

0 Nulle. Présence accrue de matière en suspension ou de turbidité. Analyse 
du substrat et de la biodiversité impossible. Déploiement CPD éliminé du 
processus d’analyse. 

1 Très faible. Présence accrue de matière en suspension ou de turbidité. 
Substrat et objets environnants difficiles ou impossibles à distinguer. 
Détection et identification du substrat et de la biodiversité impossible, sauf 
pour certains objets (ex. bloc, gallet) ou taxons de grande taille (ex. crabe, 
étoile, oursin). 

2 Faible. Présence de matière en suspension ou de turbidité. Substrat et 
objets environnants difficiles à distinguer. Détection et identification de la 
biodiversité possible dans certains cas chez certains groupes de taxons (ex. 
crabe, étoile, oursin). 

3 Moyenne. Présence de matière en suspension ou de turbidité. Substrat et 
objets environnants présentent un contour flou ou partiellement visible. 
Détection et identification de la biodiversité possible chez la plupart des 
taxons (ex. crabe, oursin, étoile, bivalve, crevette). 

4 Bonne. Faible présence de matière en suspension ou de turbidité. Substrat 
et objets environnants avec contours bien définis. Détection et identification 
de la biodiversité facilement réalisable pour la plupart des espèces 
benthiques. 

5 Excellente. Peu ou pas de matière en suspension ou de turbidité. Substrat 
et objets environnants avec contours nets. Détection et identification de la 
biodiversité faciles. Visibilité optimale pour l’observation de fins critères 
d’identification morphologiques (ex. structures, patrons de coloration 
détaillés). 
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Figure 1. Exemple d’un outil visuel pour la détermination d’une cote de visibilité pour des photos 
issues de la caméra en vue verticale (gauche) et oblique (droite) de différents déploiements CPD 
acquis dans l’estuaire du Saint-Laurent (ex. de sites avec absence de lumière naturelle de 
surface) : A) nulle, B) très faible, C) faible, D) moyenne, E) bonne et F) excellente. 

Tableau 3. Variables influençant la cote de qualité attribuée à chaque déploiement CPD. 

Variable Description 

Visibilité Conditions de visibilité sous-marine, selon la présence de matière en 
suspension, la turbidité, et la résolution des photos.  

Champ visuel Problèmes générés par l’obstruction du champ de vision, l’angle de la 
caméra, la luminosité inadéquate (ex. faible éclairage, surexposition) et 
la distorsion des photos. 

Nombre de photos 
appariées 
analysables 

Nombre de photos appariées de la séquence lors du déploiement CPD, 
qui sont utilisables à des fins d’analyses. 

  

Pour les séquences photo issues du CPD, il peut être nécessaire d’ajuster les photos avec un 

post-traitement photographique avant de débuter les analyses. En effet, lorsque la coloration de 

l’eau est teintée de brun, de jaune ou de vert, il peut être difficile de distinguer certains objets ou 

organismes présents à l’intérieur du quadrat, tels que les particules du substrat ou la végétation. 

Dans le but de corriger la couleur (teinte) des photos, il est recommandé d’effectuer une balance 
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des blancs (voir procédure 1.4 en Annexe 1). Généralement, la balance des blancs est suffisante 

pour pouvoir utiliser des propriétés de l’image telles que la luminosité, la saturation et la teinte et 

effectuer des mesures partiellement automatiques des zones de recouvrement de certains 

organismes, comme c'est le cas avec les feuilles de zostères.  

Échantillons vidéo stéréoscopiques 

Pour les séquences vidéo issues de l’échantillonnage CVSA, il est suggéré d’effectuer le 

visionnement préliminaire en mode lecture rapide. Ce visionnement consiste en une 

évaluation qualitative de la visibilité et du champ visuel des caméras, en fonction de critères 

adaptés de Watson et Huntington (2016) (Tableau 4). Cette évaluation sert à déterminer si 

l’échantillon vidéo est utilisable, en totalité ou en partie(s), pour l’extraction de données 

biologiques et écologiques. Pour ce faire, la visibilité est évaluée en termes de clarté de l’eau, 

selon la présence ou non de matière en suspension ou de turbidité (Figure 2). Le champ visuel 

est évalué selon le degré d’obstruction des caméras et le positionnement du système 

d’échantillonnage (et donc des caméras) par rapport au fond (ex. caméras inversées et orientées 

vers le haut, inclinées ou parallèles au fond) (Figure 3).  
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Tableau 4. Cotes de visibilité et champ visuel adaptés de Watson et Huntington (2016) et 
utilisées pour l’évaluation de la qualité des séquences vidéo lors du visionnement préliminaire.  

Variables Description Cote Description 

Visibilité Évaluation qualitative de 

la visibilité environnante 

en termes de clarté de 

l’eau 

 

0 Nulle. Présence accrue de matière en 

suspension ou de turbidité rendant le substrat 

indiscernable. Identification du substrat et 

des organismes impossible. 

1 Faible. Présence de matière en suspension 

ou de turbidité. Substrat et objets 

environnants difficiles à distinguer. 

Identification du substrat et des organismes  

compromise ou limitée. 

2 Moyenne. Présence de matière en 

suspension ou de turbidité. Substrat et objets 

environnants présentent un contour flou. 

Identification du substrat et des organismes 

possible, mais limitée. 

3 Bonne. Peu ou pas de matière en suspension 

ou de turbidité. Substrat et objets 

environnants sont relativement nets. 

Identification du substrat et des organismes 

possible. 

Champ 

visuel 

Évaluation qualitative du 

degré d’obstruction du 

champ visuel et 

positionnement des 

caméras par rapport au 

fond 

0 Faible. Degré d’obstruction ≥ 50% à moins de 

1 m des caméras (≈ extrémité du bras à 

appât) et/ou fond marin non visible i.e., 

caméras orientées vers le haut. 

1 Partielle. Degré d’obstruction > 0 et < 50 % à 

moins de 1 m des caméras et/ou caméras 

inclinées par rapport au fond. 

2 Bonne. Pas d’obstruction et caméras 

parallèles au fond. 
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Figure 2. Exemples des différentes catégories de visibilité rencontrées lors de l’échantillonnage 
(A) nulle, (B) faible, (C) moyenne, (D) bonne. 

 

Figure 3. Exemples des différentes catégories de champ visuel rencontrées lors de 
l’échantillonnage de gauche à droite : (A) faible, (B) partielle, (C) bonne.  
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3. ANALYSES D’IMAGERIE SOUS-MARINE 

3.1. PRÉPARATION AUX ANALYSES 

3.1.1. Logiciel de traitements d’images photo et vidéo 

Le choix d’une plateforme d’analyse pour le traitement des images revêt un caractère important 

dans l’extraction des données biologiques et écologiques contenues dans les échantillons photo 

et vidéo. Plusieurs aspects doivent être considérés, dont les objectifs de l’étude, le type 

d’échantillons, les fonctionnalités, le coût, l’accessibilité et la disponibilité à long terme de la 

plateforme. Une description des différents logiciels disponibles va au-delà des objectifs de ce 

rapport et serait vouée à une rapide désuétude étant donné l’évolution rapide des outils et 

plateformes disponibles ainsi que les progrès actuels de la discipline (Gomes-Pereira et al. 2016; 

Bowden et al. 2020; Costa et al. 2022). Dans ce contexte, nous présentons brièvement les 

logiciels sélectionnés pour analyser les séquences photo issues de l’échantillonnage CPD et les 

segments vidéo issus de l’échantillonnage CVSA; les deux méthodes d’échantillonnage sont 

détaillées dans Scallon-Chouinard et al. (2022). Les logiciels d’annotations choisis permettent 

l’extraction de données quantitatives provenant des dénombrements et des prises de mesures.  

Échantillons photo en séquence 

Le package Fiji (version 2.15.0) du logiciel ImageJ est suggéré pour le traitement des séquences 

de photos provenant du CPD. Ce logiciel d'analyse de photos multiplateforme, adapté aux 

applications en biologie, est libre d’utilisation et de source ouverte (Schindelin et al. 2012). Il 

permet l’importation d’une séquence de photos, leur annotation, ainsi que la prise de mesures en 

2D. Ce logiciel écrit en JAVA a été créé en 1997 et permet l'ajout de fonctionnalités développées 

par les utilisateurs. Initialement développé pour la microscopie (Schneider et al. 2012), ImageJ 

est utilisé dans de nombreux domaines, dont l’imagerie sous-marine (Larocque et Thorne 2012, 

Tuck et al. 2015; Kahn et al. 2020; Bowden et al. 2020; Thorne et al. 2022). Depuis sa création, 

plusieurs nouvelles fonctionnalités ont été compilées et sont disponibles sous le nom Fiji, lequel 

est régulièrement mis à jour. Avec l’utilisation des ROIs (Region of interest), il est possible 

d’annoter les photos à l’aide de points ou de polygones (voir procédures 1.3 Annexe 1) et 

d’extraire les données afin d’obtenir les aires de couverture et les décomptes des 

organismes/objets annotés.  

Échantillons vidéo stéréoscopiques 

Le logiciel EventMeasure (version 6.10) de SeaGIS (SeaGIS, 2019) est suggéré pour le 

traitement des échantillons vidéo stéréoscopiques provenant du CVSA. Ce logiciel permet 

l’annotation des vidéos pour l’identification des espèces et la prise de mesures stéréoscopiques 

sur les images, en appliquant les paramètres 2D et 3D définis lors d’une calibration réalisée au 

préalable avec le logiciel CAL de SeaGIS (Langlois et al. 2020; Scallon-Chouinard et al. 2022). 

EventMeasure permet de créer des jeux de données incluant le calcul de paramètres biologiques 

et écologiques prédéfinis, dont le nombre maximal d’individus d’une espèce compté sur une seule 

image (MaxN), le MaxN cumulatif dans le temps, le temps de première arrivée (T1st) et la distance 

minimale d’approche par espèce (Langlois et al. 2020). Une liste d’espèces personnalisée et 

codifiée peut-être incorporée au logiciel afin de faciliter les annotations d’identification. Il est 

également possible de charger les métadonnées de déploiement afin de les lier directement aux 

données d’observation et de mesures. 

https://fiji.sc/
https://fiji.sc/
https://www.seagis.com.au/event.html
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3.1.2. Champ d’analyse et calibration 

Échantillons photo en séquence 

Le champ d’analyse du CPD est un quadrat d’échantillonnage de dimensions intérieures de 50 

cm sur 50 cm ( 

Figure 4A). Les dénombrements et les prises de mesures pour les analyses du substrat et de la 

biodiversité devraient être réalisées dans cette zone. Les paramètres d’enregistrement des 

caméras suggérés sont notés dans Scallon-Chouinard et al. (2022). Selon les paramètres 

suggérés d’enregistrement des caméras et la conception du système CPD, le quadrat apparaît 

aplani et au centre de chaque photo annotée. Seules les photos en vue verticale ( 

Figure 4B) devraient être annotées et calibrées, alors que les photos avec une vue oblique 

offrent une autre perspective des sites échantillonnés et peuvent servir lors des identifications 

taxonomiques ( 

Figure 4C).   

 

Figure 4. Représentation du champ d’analyse (quadrat d’échantillonnage en vert pâle) : A) 
schéma avec dimensions du système de caméra déposé CPD, B) photo principale de la caméra 
en vue verticale et C) photo secondaire en vue oblique.  
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Il est nécessaire de calibrer les photos avec un logiciel d’analyse pour pouvoir mesurer des 

organismes ou les composantes du substrat (voir procédure 1.5, Annexe 1). La calibration de 

l’échelle de mesure (ou la photogrammétrie 2D) consiste, en général, à mesurer le nombre de 

pixels d’un objet de taille connue et à convertir ce nombre en unité de mesure. Cette calibration 

peut se faire à partir de photos acquises sur le terrain (Kohler et Gill 2006; Trygonis et Sini 2012). 

Avec le système CPD, la moyenne des quatre côtés de 50 cm du quadrat d’échantillonnage 

devrait être utilisée comme facteur de conversion alors que l’écart-type sert à estimer les 

incertitudes sur les mesures. Il est aussi possible de faire la calibration en bassin à l’aide d’un 

panneau de calibration. Cela permet de mesurer s’il y a un effet de déformation (distorsion) de 

part et d’autre du quadrat d’échantillonnage, afin de quantifier les erreurs sur les mesures 

(Larocque et Thorne 2012).  

Échantillons vidéo stéréoscopiques 

L’analyse et la prise de mesures sur échantillons vidéo stéréoscopiques nécessitent un processus 

de calibration des caméras (López-Macías et al. 2023). La calibration stéréoscopique est 

généralement effectuée en milieu artificiel (bassin) et idéalement réalisée avant et après chaque 

sortie sur le terrain. La calibration permet de générer des paramètres en deux et trois dimensions 

et à en mesurer les éventuelles déviations entre le début et la fin de l’échantillonnage (Harvey et 

Shortis 1998; Scallon-Chouinard et al. 2022). Les paramètres de calibration permettent 

d’effectuer des mesures au millimètre près sur les images vidéo et servent à quantifier la précision 

des mesures (Harvey et al. 2002; López-Macías et al. 2023).  

Selon le logiciel utilisé, l’imagerie stéréoscopique nécessite généralement d’effectuer une 

synchronisation des séquences vidéo issues des deux caméras, ainsi que le pairage des 

séquences aux fichiers de calibration appropriés, et ce, avant le début des analyses. La 

procédure pour la synchronisation des vidéos et le chargement des fichiers et paramètres de 

calibration dans le logiciel EventMeasure (EM) est décrite à l’Annexe 2 (procédure 2.5). Un 

aperçu des interfaces du logiciel et des étapes requises pour la préparation et la réalisation des 

analyses y sont aussi détaillés. 

L’importation des séquences en vue stéréoscopique, permet à l’analyste d’utiliser le champ visuel 

des deux caméras en simultané (Figure 5). L’ensemble de ce qui est visible dans l’une ou l’autre 

des caméras constitue le champ d’analyse. Toutes observations dans le champ d’analyse, en 

termes de biodiversité et d’habitat, devraient être annotées. La portion du champ d’analyse qui 

se superpose dans les deux caméras représente le champ d’analyse stéréoscopique à l’intérieur 

duquel les organismes et objets peuvent être mesurés (Figure 5). L’emplacement des caméras 

sur le système d’échantillonnage a une incidence sur les dimensions du champ d’analyse 

stéréoscopique (Harvey et al. 2010; Langlois et al. 2020; Scallon-Chouinard et al. 2022). Le 

positionnement des caméras sur le système CVSA permet la prise de mesures autant sur le fond 

que dans la colonne d’eau. 

  

https://www.seagis.com.au/event.html
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Figure 5. A) Représentation théorique 2D (vue du dessus) du champ d’analyse et du champ 
d’analyse stéréoscopique. La zone bleue représente la zone visible uniquement sur la caméra de 
gauche, la zone jaune celle visible uniquement sur la caméra de droite et la zone verte représente 
le champ d’analyse stéréoscopique. L’encadré vert représente une profondeur de champ de 
vision de 3 m (Adapté de Harvey et al. 2010 et SeaGis 2019). B) Représentation visuelle du 
champ d’analyse (avec profondeur du champ de vision d’environ 3 m), incluant le champ 
d’analyse stéréoscopique (en vert) et les champs visuels respectifs des deux caméras CVSA (en 
bleu et en jaune). 

3.1.3. Période d’échantillonnage et d’analyse 

La période d’échantillonnage correspond à la durée (visée ou réalisée) de l’enregistrement photo 

ou vidéo sur le terrain. La période d’analyse correspond à la durée du traitement et annotation 

des images afin d’en extraire des données utilisables. La période d’échantillonnage photo et vidéo 

varie selon le protocole de terrain, le type d’embarcation utilisée, et les conditions rencontrées 

lors des missions en mer. La période d’analyse dépend de la qualité des échantillons récoltés et 

des objectifs de l’étude. Les paramètres d’échantillonnage et d’analyse, en termes de durée ou 

de nombre d’images, devraient être compilés afin d’assurer la standardisation des données et 

permettre la comparaison des déploiements entre eux. 

Échantillons photo en séquence 

L’utilisation du mode photo des caméras permet d’acquérir des photos à intervalles fixes (ex. 10 

secondes), durant 1 à 2 minutes de temps au fond. Une période d’échantillonnage de 1 à 2 

minutes laisse le temps aux sédiments de se redéposer et permet d’acquérir un certain nombre 

de photos à analyser. Le nombre de photos utilisables pour les analyses en séquence varie 
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généralement entre 6 et 12 photos selon ce protocole, les conditions en mer, et la qualité des 

images. Il est aussi possible de prendre de courtes vidéos et d’en extraire les photos a posteriori 

(à l’aide d’un logiciel, e.g., VLC) pour les analyses avec séquences photo. 

Échantillons vidéo stéréoscopiques 

Lors des analyses vidéo, il est important de noter l’heure (hh :mm [UTC]) correspondant au début 

et à la fin de l’immersion du dispositif d’échantillonnage (ex. système CVSA). Cette information 

permet d’évaluer la durée totale du déploiement (période d’échantillonnage) et facilite l’arrimage 

chronologique des données environnementales récoltées à l’aide de sondes installées sur le 

système de caméras (ex. sonde température, salinité et courantomètre sur le CVSA) (Scallon-

Chouinard et al. 2022). 

La période d’analyse correspond à la période au cours de laquelle les images sont annotées et 

les données biologiques et écologiques sont extraites des séquences vidéo. Elle est encadrée 

par une première image définie comme le « temps zéro » et par une image qui marque la fin de 

la période d’annotations. Le temps zéro ou début de la période d’analyse est défini par le moment 

où les sédiments mis en suspension lors du dépôt du système d’échantillonnage sur le fond sont 

redéposés, et la visibilité redevient optimale. La fin de la période d’analyse correspond au moment 

où le dispositif d’échantillonnage est déplacé (modification du champ d’analyse) et/ou quitte le 

fond pour sa remontée. Selon les objectifs de l’étude et le logiciel utilisé, il est possible de 

déterminer d’autres périodes d’une durée fixe à l’intérieur de la période d’analyse. L’usage de ces 

périodes permet de comparer les observations à l’intérieur d’un même déploiement/échantillon 

(ex. variabilité temporelle dans l’abondance d’un taxon en particulier), et peut servir à réduire la 

durée totale de l’analyse en facilitant une approche par sous-échantillonnage (ex. analyse de 

séquences d’une minute à chaque intervalle de 30 minutes pour la caractérisation des 

communautés d’invertébrés (Devine et al. 2019)). La période d’analyse est souvent variable entre 

les déploiements et doit être standardisée afin d’assurer la comparabilité des données recueillies. 

3.1.4. Stratégie d’analyse 

Échantillons photo en séquence 

Une méthode d’analyse dynamique des photos en séquence est suggérée pour donner un 

mouvement aux images (lors du déroulement rapide de la séquence à l’aide d’un logiciel), ce qui 

augmente les chances de détection des organismes. Grâce à cette méthode, plusieurs 

organismes enfouis dans le substrat ou cachés dans les interstices peuvent être observés et 

annotés. Elle permet, dans certains cas, la distinction entre les organismes morts ou vivants, 

notamment chez les bivalves. Le logiciel Fiji permet le visionnement et l’annotation dynamique 

de séquences photo en mouvement. La navigation fluide sur les photos en séquence à différents 

grossissements facilite l’analyse. L’utilisation de séquence de photos (6 photos/minutes) offre un 

compromis intéressant entre les photos uniques et les vidéos, c’est-à-dire, pour une même 

caméra, une séquence photo permet une détection comparable, un temps d’analyse réduit, et 

nécessite moins d’espace d’archivage comparativement à un déploiement vidéo d’une même 

durée. 

Échantillons vidéo stéréoscopiques 

Afin de faciliter l’extraction des données et l’optimisation du temps, il est recommandé d’appliquer 

une stratégie de visionnement et d’annotations des échantillons vidéo. Une bonne pratique 

consiste à réaliser un balayage de séquences, c’est-à-dire un visionnement en alternant des 

https://www.videolan.org/vlc/
https://fiji.sc/
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avances rapides et des rembobinages en mode accéléré, suivi d’un visionnement en temps réel. 

Le balayage des séquences en mode accéléré est effectué sur les vidéos des caméras gauche 

et droite (en alternance), et sert à détecter et annoter la plupart des organismes. En effet, le 

balayage des séquences permet de mettre en évidence la présence et les déplacements à peine 

perceptibles en temps réel de certains organismes peu mobiles (p. ex. gastéropodes et autres 

organismes en étroite association avec le fond). Le visionnement en temps réel en stéréo (lecture 

simultanée des vidéos de la caméra gauche et de la droite) permet d’augmenter la probabilité de 

détecter des spécimens qui passent rapidement dans le champ d’analyse, tels que les espèces 

de poissons et crevettes, afin de compléter les annotations. La stéréoscopie permet d’annoter les 

organismes présents sur l’une ou l’autre des images de gauche et de droite ou les deux, et selon 

le logiciel utilisé, il sera préconisé d’effectuer les annotations sur une seule des deux images, en 

général l’image de gauche (Hulls 2013, Unsworth et al. 2014) (voir section 3.4.3 au bas). Lors 

des analyses, il est recommandé de sauvegarder les images fixes de qualité et les séquences 

vidéo exceptionnelles pouvant contribuer au développement d’une banque de références. 

3.2. SUIVI DES CONDITIONS ENVIRONNEMENTALES (ÉCHANTILLONS 

VIDÉO SEULEMENT) 

L’évaluation initiale et le suivi des conditions environnementales rencontrées lors de 

l’échantillonnage vidéo permettent de tenir compte de facteurs généralement non contrôlables et 

susceptibles d’influencer la détectabilité de la méthode. Il est recommandé d’évaluer les 

conditions environnementales initiales au temps zéro de la période d’analyse, et d’annoter les 

changements de courants, luminosité, turbidité, profondeur du champ de vision, obstruction du 

champ visuel des caméras et apparition/disparition de bruits sonores sur toute la période 

d’analyse (voir procédure 2.6 Annexe 2). 

Le courant est un paramètre clé pour les systèmes d’échantillonnage visuel appâtés. La direction 

et la vitesse du courant déterminent la diffusion de l’appât et peuvent affecter l’activité et le 

comportement des organismes, et donc influencer de manière significative la détectabilité des 

espèces mobiles telles que les crabes et les poissons (Stoner 2004; Bacheler et al. 2014). 

L’évaluation des conditions de courant préconisée pour un dispositif d’échantillonnage tel le 

CVSA, consiste à catégoriser la direction du courant par rapport à la cage d’appât et son intensité 

(faible, modérée ou forte). 

La lumière naturelle et les lampes peuvent influencer le comportement de certains organismes, 

en induisant des comportements de fuite ou d’attraction à la lumière (phototaxie) (Ryer et al. 

2009; Harvey et al. 2012; Rooper et al. 2015). Ainsi, la luminosité peut avoir un effet indirect sur 

la détectabilité des organismes, en occasionnant des biais pour certaines espèces. L’occurrence 

(ou non) et l’ampleur de ces effets ou biais dépendront de l’habitat et de la communauté 

échantillonnée. L’évaluation des conditions de luminosité recommandée considère la présence 

ou l’absence de lumière naturelle sur le site d’échantillonnage, ainsi que le fonctionnement 

(normal ou anormal) des lampes dont est équipé le système d’échantillonnage vidéo. 

La stéréoscopie permet de déterminer quantitativement la profondeur du champ de vision 

stéréoscopique (PCVS) des caméras, correspondant à la distance maximale à laquelle les 

éléments du substrat ou les organismes sont encore visibles et identifiables (i.e., présentant des 

contours relativement bien définis) dans les vidéos des deux caméras (Harvey et al. 2002). La 

PCVS est une mesure en trois dimensions réalisée en utilisant un repère visible sur le fond 

(Whitmarsh et al. 2017). Dans l’absence de repère visible sur le fond, la mesure quantitative de 
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la PCVS n’est pas possible, alors la catégorie est estimée visuellement. Lorsque c’est possible, 

il est suggéré d’effectuer une nouvelle mesure de PCVS dès qu’un changement de courant, 

luminosité, turbidité ou qu’une obstruction du champ visuel est détecté en cours d’analyses. 

Le courant, la luminosité, la turbidité, la PCVS et le degré d’obstruction du champ visuel, sont des 

paramètres souvent corrélés exprimant différents aspects des conditions de visibilité rencontrées 

lors de l’échantillonnage visuel, et ayant une incidence sur la détectabilité. Les changements de 

luminosité et de turbidité en fonction du courant, par exemple la présence soudaine de matières 

en suspension dans la colonne d’eau, influencent la PCVS. La présence et les variations de 

l’intensité de la lumière naturelle provenant de la surface peuvent parfois modifier les contrastes 

existants entre les organismes et l’arrière-plan (Salman et al. 2016; López-Macías et al. 2023). 

Une augmentation de la turbidité peut réduire la finesse des structures pouvant être visibles sur 

les vidéos (Codevilla et al. 2015). L’obstruction (totale ou partielle) du champ visuel des caméras 

aura pour effet de restreindre le champ d’analyse et la PCVS, diminuant ainsi la détectabilité des 

organismes présents sur le site (Figure 6). Dans tous les cas, l’effort d’échantillonnage s’en trouve 

modifié, ce qui peut avoir un impact sur les analyses et leur interprétation. Avec les aspects 

techniques des caméras (i.e. réglage ISO et nombre de pixels), les facteurs environnementaux 

affecteront la détectabilité et la mesurabilité des organismes, ainsi que la résolution taxonomique 

des identifications à l’intérieur de l’échantillon. Il est suggéré d’en faire le suivi séparément, ce qui 

permettra d’évaluer leurs effets respectifs sur la qualité et la quantité des données biologiques et 

écologiques récoltées à partir des échantillons vidéo.  

L’apparition et la disparition de sons dans l’environnement marin sont susceptibles d’influencer le 

comportement et l’occurrence des organismes dans le secteur d’échantillonnage. Ces sons 

comprennent les bruits d’origine anthropique et les sons produits par les animaux marins. 

L’utilisation d’outils permettant la visualisation audio (Figure 7) peut faciliter la détection de 

changements importants dans l’environnement sonore an cours de l’échantillonnage. Les 

moments d’apparition/disparition de sons sont ensuite rapportés et annotés dans l’analyse 

d’images en identifiant la source ou l’origine probable du son.  

 

Figure 6. Exemple d’un changement de conditions environnantes ayant une influence sur la 
détectabilité de la méthode vidéo : obstruction partielle des caméras par des amphipodes (Classe 
Amphipoda), à l’intérieur de la période d’analyse. 
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Figure 7. Visuel audio obtenu avec l’outil de visualisation audio du logiciel Open Shot. Dans cet 
exemple, les ondes sonores visibles en bleu sont bien définies et correspondent à des périodes 
de bruits de moteurs enregistrés lors d’un déploiement CVSA. 

Les tableaux 5 et 6 décrivent les paramètres et annotations utilisées pour évaluer les conditions 

initiales (Tableau 5) et changements de conditions environnementales en cours d’analyse 

(Tableau 6). L’évaluation des conditions initiales sert de référence pour comparer les conditions 

environnementales observées entre échantillons vidéo, et pour déterminer, ultérieurement et au 

besoin, la nature et l’amplitude des changements de conditions observés au cours de la période 

d’analyse à l’intérieur d’un même échantillon. 

 
Tableau 5. Description des paramètres et catégories suggérées pour l’évaluation qualitative des 

conditions environnementales initiales au temps zéro (T0) de la période d’analyse. 

Champ Description 
du champ 

Catégorie principale Catégorie secondaire 

Valeur Description Valeur Description 

Lum_i Luminosité 
initiale 
 

a  Présence de lumière 
naturelle de surface  

1  Éclairage normal (les 
deux lampes 
fonctionnent bien)  

b  Absence de lumière 
naturelle de surface  

2  Éclairage partiel (une 
des lampes est éteinte 
ou intensité lumineuse 
réduite)  

PCVS_i Profondeur 
du champ 
de vision 
stéréoscopi
que (PCVS) 
initiale 

a  < 0.5 m (cage à 
appât non visible)  

NA NA 

b  Environ 1 m (pas de 
visibilité au-delà de la 
cage à appât)  

NA NA 

c  1 à 2 m  NA NA 

d  2 à 3m  NA NA 

e  > 3 m  NA NA 

Courant_i Direction et 
intensité du 
courant 
initiale 

a  Courant de face  1  Intensité faible   

b  Courant arrière 2  Intensité modérée  

c  Courant de gauche à 
droite  

d  Courant de droite à 
gauche  

3  Intensité forte  

e  Indéterminé  

 

  

https://www.openshot.org/
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Tableau 6. Description des paramètres et catégories suggérées pour l’annotation qualitative des 

changements dans les conditions environnementales au cours de la période d’analyse. 

Paramètre de 
suivi  

Exemples d’annotation Description 

Luminosité 
(L_) 

L_apparition lum naturelle 
L_baisse lumiere droite 

Noter la nature et/ou la cause du changement de 
luminosité 

Courant (F_) F_b1 
F_c3 

Noter la nouvelle direction et intensité du courant 
selon les catégories décrites au Tableau 5 

Turbidité (T_) T_diminue 
T_augmente 
 

Noter toute augmentation ou diminution de la 
turbidité de l’eau, incluant la présence de matière 
en suspension  

Obstruction 
du champ 
visuel des 
caméras (O_) 

O_partielle_cam gauche 
cordage 
O_partielle amphipodes 
O_totale bioperturbation 
myxines 

Noter l’amplitude (partielle ou totale) et la nature 
ou la cause de l’obstruction  

Profondeur du 
champ de 
vision 
stéréoscopiqu
e (PCVS_) 

PCDV_a 
PCDV_c 

Noter à quelle catégorie de PCVS décrite au 
tableau 5 correspond la nouvelle mesure PCVS  

Bruit (B_) B_moteurs – Debut 
B_moteurs – Fin 

Noter l’apparition/disparition et la source 
apparente de bruits  

 

3.3. ANALYSE DU SUBSTRAT 

Le substrat constitue une propriété de l’habitat influençant grandement la biodiversité des 

organismes benthiques de par sa nature, sa dynamique et sa complexité (Jumars et Nowell 1984; 

Valentine et al. 2005; Kovalenko et al. 2012). Contrairement aux échantillons physiques comme 

les carottes de sédiment, les échantillons visuels (photo et vidéo) permettent uniquement de 

catégoriser le substrat superficiel. Des catégories de substrat fondées sur l’origine et la taille des 

particules ont été générées en adaptant les standards disponibles aux limites des méthodes 

visuelles déposées (Tableau 7). Le système de classification du Coastal and Marine Ecological 

Classification Standard (CMECS; FGDC 2012) peut être adapté à de multiples échelles pour 

permettre de répondre à différents objectifs, en employant un vocabulaire commun. Le type de 

substrat peut être géologique, biogénique ou anthropogénique, et les catégories peuvent être 

regroupées à différents niveaux hiérarchiques/taxonomiques (Kingon 2018) afin de caractériser 

et cartographier l’habitat benthique.  
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Tableau 7. Catégories de substrat suggérées pour classifier le substrat superficiel dans les 

échantillons d’imagerie sous-marine (photo et vidéo). Adapté de Coastal and Marine Ecological 

Classification Standard (CMECS; FGDC 2012).  

Origine Catégorie de substrat superficiel 
(échantillons vidéo)  

Catégorie de substrat superficiel 
(échantillons photo) 

Géologique Roche-mère ou autre substrat 
rocheux (> 2000 mm) 

Roche-mère ou autre substrat 
rocheux (> 500 mm) 

Bloc (256 à < 2000 mm)  Bloc (256 à < 500 mm)  

Galet (64 à < 256 mm)  Galet (64 à < 256 mm)  

Caillou (4 à < 64 mm)  Caillou (4 à < 64 mm)  

Granules ou Particules fines (vase 
ou sable) (< 4 mm)  

Granules (2 < 4 mm)  

Particules fines  (vase ou sable) (< 
2 mm)  

Biogénique Coquille entière ou fragment (ex. 
mollusques, balanes) 

Banc coquillier aggloméré (> 
500 mm) 

Galet de coquillage (64 à < 
256 mm)  

Fragment de coquillage (2 à < 
64 mm)  

Sable de coquillage (< 2 mm)  

Débris de bois (Fin ou grossier) Débris de bois très grossier (256 à 
< 500 mm)   

Débris de bois grossier (64 à < 
256 mm)   

Débris de bois fin (4 à < 64 mm) 

Autre substrat biogénique 
(ex. rhodolites, MO)  

Détritus organique 

Substrat de rhodolites 

Anthropogénique Structure anthropogénique (ex. 
déchets, engin)  

Structure anthropogénique (ex. 
déchets, engin)  

Inconnu Substrat inconnu Substrat inconnu (couverture 
faunique) 

Substrat inconnu (couverture 
végétale) 

Substrat inconnu (dur) 

Substrat inconnu (autre) 

 

Échantillons photo en séquence 

Les dispositifs de caméras déposés équipés d’une caméra orientée vers le bas et d’un quadrat, 

tel le CPD, permettent d’échantillonner une superficie connue du fond marin. Les échantillons 

photo ainsi récoltés offrent la possibilité d’effectuer des analyses de photogrammétrie afin de 

déterminer semi-quantitativement la composition du substrat superficiel. Cette approche 

nécessite d’effectuer une calibration préalable du logiciel d’imagerie pour la prise de mesures 

(voir la procédure 1.4 en Annexe 1 pour le logiciel Fiji). 

L’analyse des particules superficielles du substrat proposée est basée sur la méthode semi-

quantitative proposée par Larocque et Thorne (2012). Une grille de 49 points équidistants est 

https://fiji.sc/
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générée à l’intérieur du quadrat (Figure 8). Chaque point est associé à une des 20 catégories 

décrites au Tableau 7. Une fois tous les points annotés, la composition relative des particules 

superficielles de substrat est calculée en sommant chaque catégorie et en rapportant la valeur 

en pourcentage du nombre de points total. Les données peuvent servir à déterminer la 

catégorie de substrat primaire et secondaire. Pour les substrats géologiques non consolidés, il 

est possible de caractériser les mélanges de substrats grossiers et fins selon l’approche de 

classification proposée par le standard du CMECS (Folk, 1954; FGDC 2012). La procédure 

d’analyse photogrammétrique du substrat sur les échantillons photo avec le logiciel Fiji est 

détaillée en Annexe 1 (voir procédure 1.6).  

 

Figure 8. Analyse photogrammétrique pour déterminer le pourcentage relatif de chaque 
composante du substrat superficiel dans un échantillon photo à l’aide du logiciel Fiji. La grille de 
points est superposée à la photo à l’intérieur du quadrat d’échantillonnage CPD (gauche) où 
chaque point est alors identifié à la bonne catégorie (droite). Dans cet exemple, les blocs, les 
galets et les cailloux représentent 76 % de la composition du substrat superficiel. Les particules 
fines en composent 12 % et les coquillages 10 % tandis que le reste fait partie de la catégorie 
inconnu.  

https://fiji.sc/
https://fiji.sc/
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Échantillons vidéo stéréoscopiques 

L’échantillonnage vidéo stéréoscopique standard ne contient pas de caméras dirigées vers le 

fond. Dans ce cas, l’analyse du substrat ne peut être que qualitative. La résolution et le nombre 

de catégories de substrat sont comparativement réduits (Tableau 7). L’analyse suggérée consiste 

à déterminer les substrats superficiels principal et secondaire à l’intérieur du champ d’analyse 

des deux caméras. L’évaluation du substrat principal consiste à identifier la catégorie 

représentant la plus grande couverture du fond marin. Le substrat secondaire est la deuxième 

catégorie en importance en termes de couverture. L’utilisation des outils de mesures 

stéréoscopiques peut s’avérer nécessaire lors de l’évaluation de la taille des composantes du 

substrat. Des exemples visuels des différentes combinaisons de substrats principaux et 

secondaires observés dans des échantillons vidéo CVSA acquis dans l’estuaire et le golfe du 

Saint-Laurent sont présentés à la Figure 9. L’analyse suggérée du substrat dans les échantillons 

vidéo s’inscrit dans la procédure d’évaluation des conditions environnementales initiales et est 

détaillée à l’Annexe 2 (voir procédure 2.6). 
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Figure 9. Exemples des différentes catégories de substrat principal (P) et secondaire (S) observés 
dans des échantillons vidéo CVSA dans l’estuaire et le Golfe du Saint-Laurent : A) roche-mère 
ou autre substrat rocheux ( ≥ 2000 mm) (P & S), B) bloc (256 à < 2000 mm) (P) et granule ou 
particules fines (vase ou sable) (< 4 mm) (S), C) galet (64 à < 256 mm) (P) et caillou (4 à < 64 mm) 
(S), D) caillou (4 à < 64 mm) (P) et coquille entière ou fragment (ex. mollusques, balanes) (S), E) 
granule ou particules fines (vase ou sable) (< 4 mm) (P) et substrat inconnu (S); F) coquille entière 
ou fragment (ex. mollusques, balanes) (P) et granule ou particules fines (vase ou sable) (< 4 mm) 
(S), G) substrat inconnu (P & S). 
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Figure 9 « suite ». E) Granule ou particules fines (vase ou sable) (< 4 mm) (P) et substrat inconnu 

(S), et F) coquille entière ou fragment (ex. mollusques, balanes) (P) et granule ou particules fines 

(vase ou sable) (< 4 mm) (S); G) substrat inconnu (P & S). 

3.4. ANALYSE DE LA BIODIVERSITÉ 

Les échantillons visuels permettent de générer des données sur l’occurrence, l’abondance et la 

diversité des organismes marins. Nonobstant l’approche ou le logiciel d’analyse utilisé, le 

processus d’extraction des données de biodiversité consiste à repérer les organismes dans les 

échantillons photo et/ou vidéo, les annoter, et les identifier. Pour chaque unité taxonomique 

observée, annotée et identifiée, le dénombrement des individus permet de générer des données 

d’abondance. Selon le type d’échantillon et les objectifs de l’étude, les données d’abondance 

seront quantifiées et standardisées par unité de surface (densité, échantillonnage photo ou vidéo 

en vue orientée vers le fond) ou de temps (abondance maximale relative observée, 

échantillonnage vidéo en continu en vue horizontale/parallèle au fond). 

3.4.1. Approche taxonomique 

L’identification taxonomique dans les échantillons visuels est basée sur les caractéristiques 

visibles des organismes. Le niveau taxonomique des identifications est donc influencé par la 
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résolution des images, par la source et le type d’éclairage sous-marin utilisé, par les conditions 

environnementales déterminant la visibilité au moment de (ou pendant) l’échantillonnage, et par 

les enjeux spécifiques à certains taxons (i.e., critères de différenciation invisibles à l’œil nu ou 

avec un grossissement des images). Ainsi, il est fréquent que la résolution taxonomique varie 

d’un type d’organisme à l’autre, mais aussi au sein d’un même type d’organisme (Bowden et al. 

2020).  

Tous les macro-organismes détectés sur les images sont identifiés au plus bas niveau 

taxonomique possible. Les connaissances disponibles sur l’écologie des espèces (ex. aire de 

répartition combinée à l’absence d’organismes de même rang taxonomique à l’intérieur de cette 

aire), peuvent être mobilisées pour valider ou affiner les identifications. Celles-ci devraient 

cependant être utilisées avec prudence dans un contexte de changement climatique (Araùjo et 

Rahbek 2006; Moullec et al. 2022).  

Le recours à la taxonomie linnéenne peut s’avérer limitant pour distinguer les types d’organismes 

ayant des morphologies analogues ou similaires. Les organismes érigés ou encroûtants, 

notamment les ascidies (classe Ascidiacea), les bryozoaires (embranchement Bryozoa), les 

macroalgues (e.g., règne Chromista), ainsi que les éponges (embranchement Porifera), peuvent 

nécessiter l’usage de la microscopie ou de la génomique pour une identification taxonomique 

fiable et robuste (Althaus et al. 2015; Dinn 2020). Dans ces cas particuliers, l’usage de 

regroupements, morphotypes, ou unités taxonomiques opérationnelles (OTU, Operational 

Taxonomic Unit), devrait être préconisé (Chauvet et al. 2018). L’utilisation de morphotypes, 

regroupements et/ou des OTUs permet de générer des identifications qui tiennent compte de la 

diversité fonctionnelle. Ce niveau d’identification est utile d’un point de vue bioécologique, car il 

permet de décrire des communautés ou habitats peu connus en termes de fonctionnalité et rôles 

écologiques (FGDC 2012; Althaus et al. 2015). Une approche par morphotypes, regroupements 

ou OTUs est préconisée pour l’identification des éponges (Côté et al. 2021), l’identification des 

hydrozoaires et bryozoaires, et peut être utilisée pour les macroalgues (ex. Althaus et al. 2013; 

Grégoire et al. 2022). Par exemple, certains hydrozoaires et les bryozoaires érigés (sessiles) 

peuvent être regroupés sous le nom de « BryoHydrozoa » (ex. Michaelis et al. 2019) s’ils sont 

impossibles à distinguer dans les images. Des regroupements ou des OTUs peuvent aussi être 

utilisés afin d’optimiser l’identification et la résolution taxonomique chez certaines espèces de 

poissons ou d’invertébrés, au besoin. L’utilisation des morphotypes, regroupements, et OTUs, 

permet d’optimiser les informations disponibles dans les échantillons visuels et d’augmenter les 

connaissances en lien avec des objectifs spécifiques, mais ne permet pas d’effectuer des 

correspondances taxonomiques directes et utiles lors de la diffusion des données sur des 

plateformes publiques standardisées (e.g., WoRMS, GBIF). Le développement de bases de 

données ouvertes spécifiques à l’imagerie sous-marine, devrait permettre de palier à cette 

limitation dans le futur. 

La taxonomie étant évolutive (Horton et al. 2021), il est suggéré de travailler avec une liste 

taxonomique de référence codifiée et régulièrement mise à jour. En effet, l’usage d’un code fixe 

permet d’associer les organismes dans les images à un identifiant (code) unique lié à un nom 

scientifique. Ce dernier étant sujet à des révisions et mises à jour, l’usage de codes fixes permet 

de tenir compte des changements de noms, tout en en assurant la réplicabilité des analyses. Un 

exemple de liste de référence codifiée est le registre mondial des taxons (WoRMS) avec son 

code AphiaID fixe et unique pour chaque nom scientifique (Vandepitte et al. 2015). Les guides, 

les catalogues de photos et les autres publications avec des descriptions ou des données de 
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distribution par taxon, servent de référence pour la validation des identifications et les annotations 

des images (ex. Chabot et Rossignol 2003 pour les algues; Savard et Nozères 2012 pour les 

crevettes; Bourdages et al. 2012 pour les mollusques; Nozères 2017 pour les poissons; Isabel et 

al. 2024 pour les invertébrés ). L’usage d’un guide de référence d’imagerie sous-marine 

développé pour un écosystème donné (ex. Wudrick et al. 2020 pour le dôme Orphan; Savenkoff 

et al. 2017 pour le Banc des Américains; Grégoire et al. 2022 pour la zone côtière de l’estuaire et 

du golfe du Saint-Laurent), peut faciliter le travail d’identification, minimiser les risques d’erreur et 

limiter les divergences d’identification entre les analystes. 

Une étape importante représentant une bonne pratique dans le contrôle de qualité des 

identifications taxonomiques est la validation croisée. Cette pratique de validation entre 

taxonomistes est communément utilisée dans les collections de référence et représente une 

technique répandue en imagerie sous-marine. Il est recommandé de conserver un registre des 

auteurs des identifications ainsi que des personnes références et experts taxonomiques ayant 

validé les identifications. Il est possible de mettre sur pied un système de registre simple dans 

lequel les photos ou séquences vidéo nécessitant une validation croisée sont archivées. Ce type 

de registre permet d’assurer le suivi des identifications et le développement d’un consensus entre 

les experts taxonomistes. Ce registre peut être archivé afin d’assurer la traçabilité des 

identifications et faciliter les révisions sur certains taxons. Le registre peut se limiter aux cas 

problématiques ou être exhaustif et s’étendre à l’intégralité des identifications. La validation 

croisée peut se faire de façon intégrée dans certains logiciels d’imagerie (ex. logiciel BIIGLE, 

Langenkämper et al. 2017). Il est également possible d’avoir recours à des plateformes 

spécialisées faisant appel à un bassin plus large d’expertise taxonomique (ex. iNaturalist). Une 

approche de validation croisée faisant intervenir différents experts permettra de générer des 

identifications robustes avec un haut degré de fiabilité en support à l’étude de la biodiversité. 

3.4.2. Nomenclature ouverte 

Le concept de nomenclature ouverte permet de tenir compte de l’incertitude et des progrès 

rapides dans l’identification taxonomique à partir d’échantillons visuels (Horton et al. 2021). La 

nomenclature ouverte consiste en l’ajout de certains termes ou abréviations aux identifications 

taxonomiques, de manière à documenter et incorporer l’incertitude (Sigovini et al. 2016). 

L’approche permet aux analystes de fournir un supplément d’information concernant le niveau de 

certitude de l’identification taxonomique et la raison principale expliquant cette situation. Plusieurs 

raisons peuvent expliquer la décision d’un analyste ou d’un groupe de taxonomistes de ne pas 

aller plus bas dans l’identification de certains taxons en imagerie. Dans certains cas, cela peut 

être une insuffisance de temps, de ressources ou de connaissances. Dans d’autres cas, même 

avec des ressources illimitées, c’est l’ambiguïté relative à l’échantillon et au spécimen observé, 

notamment la visibilité, la prise de vue, la qualité de l’image ou la taxonomie incertaine qui limite 

l’identification. La collecte de spécimens pour l’examen de critères microscopiques ou des 

analyses génétiques peut être requise afin de confirmer et/ou d’améliorer certaines identifications.  

Deux abréviations sont couramment utilisées et intégrées aux bases de données afin de mettre 

en œuvre le concept de nomenclature ouverte :  

1. stet. = (stetit) : Plusieurs structures étant des critères d’identification sont visibles. 

L’identification taxonomique à un plus bas niveau semble possible, mais nécessite une 

validation par les pairs ou la décision de ne pas aller plus bas a été prise.  

 

https://biigle.de/
https://www.inaturalist.org/
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2. indet. = (Indeterminabilis) : La qualité visuelle de l’image ou position de l’organisme ne 

permet pas de voir les principales structures étant des critères d’identification. 

L’identification taxonomique à un plus bas niveau est incertaine ou impossible.  

Des exemples de leur utilisation sont disponibles dans Carpenter et al. (2015) et Fassbender et 

al. (2021). L’abréviation inc. (incerta) peut être utilisée en cours d’analyse et durant le processus 

de validation taxonomique, pour indiquer 1) que l’identification est incertaine ou 2) qu’une 

identification à un niveau plus bas est incertaine (Hanafi-Portier et al. 2021; Horton et al. 2021). 

Cependant, afin d’éviter de partager des données incertaines sur les plateformes ouvertes (ex. 

Ocean Biodiversity Information System (OBIS), Global Biodiversity Information Facility (GBIF)), il 

est recommandé de réévaluer ces identifications à des niveaux plus hauts pour résoudre, ou 

sinon exclure, les noms scientifiques incertains des données partagées sur ce type de plateforme. 

L’abréviation confer (cf.) peut alors être utilisée et intégrée dans les jeux de données afin de relier 

des identifications qui pourraient éventuellement être associées. Un exemple de données 

d’occurrence de la biodiversité pour le système CPD, accompagnées de données de 

nomenclature ouverte, est publié sur OBIS Canada, avec des remarques sur les incertitudes et 

les noms originaux attribués dans des champs standardisés (DarwinCore) (Lévesque et al. 2023). 

3.4.3. Dénombrement des organismes 

Échantillons photo en séquence 

L’analyse d’une séquence de photos en mode dynamique, plutôt qu’une seule image fixe, permet 

d’augmenter la détectabilité des organismes (mobiles et immobiles). En se basant sur un 

échantillon de 50 déploiements CPD réalisés dans la zone 10-50 mètres de profondeur sur la 

côte nord de l’estuaire maritime du Saint-Laurent et choisis aléatoirement parmi un total de 932 

analysés par une seule analyste entre 2019 et 2022 (Lévesque et al. 2023), les séquences photo 

visualisées en mode dynamique permettent de détecter, en moyenne, 16.5 individus de plus que 

les photos fixes visualisées de manière indépendante et statique (test de t apparié avec 9999 

permutations, p = 0.004). Cette forte différence est influencée par quelques sites ayant des bancs 

de bivalves, mais elle reste tout de même significative (test de t apparié avec 9999 permutations, 

n = 48, p = 0.017) avec 2.3 individus lorsque ces sites sont exclus. 

Il est suggéré que les observations soient réalisées sur l’ensemble de la séquence et soient 

annotées sur la photo principale (celle-ci étant sélectionnée lors du visionnement préliminaire 

pour chaque déploiement). Tous les individus devraient être marqués par un point et associé à 

un identifiant taxonomique (Figure 10). Les organismes qui sont dénombrés doivent être 

présents à l’intérieur du quadrat (> 50% de l’individu), afin de calculer la densité (individus/m2). 

Différents indices de biodiversité (Kenchington et al. 2022) et d’abondance peuvent être estimés 

selon les objectifs de l’étude. Les photos annotées devraient être sauvegardées afin d’assurer 

un contrôle de qualité des identifications et des dénombrements. La plupart des logiciels 

d’imagerie permettent de calculer le nombre total d’individus par taxon et de fournir des jeux de 

données brutes avec les coordonnées X, Y de chaque point annoté (pour Fjii voir procédure 1.7 

en Annexe 1).  

https://obis.org/
https://www.gbif.org/fr/
https://dwc.tdwg.org/
https://fiji.sc/
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Figure 10. Interface d’analyse avec les points d’annotation sur la photo principale sélectionnée 
d’une séquence de 14 photos, lors d’un dénombrement des organismes marins (Interface Fiji 
avec la séquence de photos à analyser, la boîte de dialogue ROI Manager et la liste de noms 
pour l’annotation des taxons). 

Afin d’assurer une méthodologie constante entre les analystes, il est nécessaire d’établir des 

règles quant à l’inclusion/exclusion des individus par rapport au quadrat. En effet, il est suggéré 

que seuls les individus dont plus de la moitié (50 %) du corps se retrouve à l’intérieur des limites 

du quadrat soient dénombrés. Dans le cas des organismes mobiles (ex. crabes, crevettes), ils 

devraient être présents sur la photo sélectionnée de la séquence; autrement, ils devraient être 

exclus du décompte. Les organismes immobiles ou peu mobiles détectés sur la séquence 

devraient être dénombrés, même s’ils sont enfouis ou dissimulés sur la photo principale (ex. 

bivalves fouisseurs, vers sédentaires). Lorsqu’un taxon est très abondant dans un échantillon, 

en faire le décompte peut s’avérer difficile et demander trop de temps. Dans ces cas, une 

approche standardisée recommandée consiste à décomposer la photo en plusieurs cellules en 

superposant une grille sur le quadrat. Il faut ensuite compter le nombre de cellules où 

l’organisme est présent et de systématiquement sous-échantillonner (selon le protocole établi) 

un certain nombre de ces cellules, afin d’obtenir une moyenne d’individus par cellule et 

d’extrapoler à l’ensemble des cellules où le taxon est présent (Figure 11). Il est important de 

mentionner « banc » ou « agrégation » en commentaires afin d’avoir un suivi des données 

estimée de cette façon. 

https://fiji.sc/
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Figure 11. Exemple de la superposition d’une grille découpant la photo du quadrat en cellules 
pour l’estimation du dénombrement des individus de la classe Bivalvia (interface Fiji avec la 
séquence de photos à analyser). Dans cet exemple, le nombre d’individus moyen par cellule est 
calculé à partir d’un sous-échantillon de 8 cellules (bleu) sur les 56 cellules de la grille où le taxon 
est présent. Avec un nombre moyen de 18,75 individus par cellules, une densité de 1050 individus 
est obtenue pour le quadrat. 

Échantillons vidéo stéréoscopiques 

Tous les organismes observés dans le champ d’analyse vidéo devraient être annotés, identifiés 

et dénombrés par taxon. Les dénombrements devraient être effectués en continu pendant toute 

la période d’analyse. Selon le logiciel utilisé pour l’analyse stéréoscopique, les annotations 

s’effectuent sous forme de points sur un des deux vidéos, généralement celui de gauche (Figure 

12A). Tous les individus visibles sur ce vidéo devraient être annotés, alors que ceux uniquement 

visibles sur le vidéo de droite devraient être marqués d’un point sur la barre de la cage à appât 

(Figure 12B). Cette approche permet de comparer l’impact d’un échantillonnage restreint (vidéo 

de gauche seulement) par rapport à un échantillonnage complet (vidéos de gauche et droite) sur 

les données d’abondance issues de l’échantillonnage en stéréoscopie. Plusieurs études limitent 

leur champ d’analyse pour les dénombrements à un seul des deux vidéos (Hulls 2013; Unsworth 

et al. 2014; Díaz-Gil et al., 2017; Miller et al. 2017). D’autres vont dénombrer les organismes 

observés uniquement à l’intérieur du champ d’analyse stéréoscopique, en effectuant la somme 

https://fiji.sc/
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des individus observés et mesurés par taxon. Cette approche permet de quantifier l’aire du champ 

d’analyse stéréoscopique afin d’estimer l’abondance relative des taxons par unité de surface 

(densités) (Harvey et al. 2004; Langlois et al. 2020). 

La principale distinction d’un protocole d’analyse vidéo, par comparaison aux analyses photo, est 

la nécessité de documenter l’augmentation du nombre d’individus d’un même taxon dans le 

temps. Cette pratique sert à identifier, à l’intérieur de la période d’analyse définie pour chaque 

échantillon ou type d’organismes, le moment correspondant au nombre maximal d’individus d’un 

même taxon présents et visibles à l’intérieur du champ d’analyse (MaxN) (Langlois et al. 2020). 

Le MaxN est un paramètre conservateur couramment utilisé en analyses vidéo pour estimer 

l’abondance relative des espèces marines par unité de temps (Whitmarsh et al. 2017). L’usage 

du MaxN permet de minimiser les biais associés aux comptages répétitifs d’un même individu à 

l’intérieur de la période d’analyse, ou pseudoréplication (Cappo et al. 2006; Schobernd et al. 

2014; Watson et Huntington 2016).  

Une bonne pratique en analyses vidéo consiste à effectuer un décompte initial des organismes 

présents au début de la période d’analyse, sur l’image de départ (voir procédure 2.7.1 en Annexe 

2). Les organismes coloniaux, tels que les hydrozoaires, les bryozoaires, les éponges, et certains 

tuniciers, devraient être annotés d’un point sans être dénombrés. Tous les autres organismes 

devraient être annotés et dénombrés, dans la mesure du possible. Deux approches de 

dénombrement des organismes mobiles peuvent être envisagées: 

1. Les spécimens sont annotés et dénombrés jusqu’à l’atteinte du MaxN pour chaque taxon 

à l’intérieur de la période d’analyse.  

2. Les spécimens sont annotés et dénombrés jusqu’à l’atteinte du nombre maximal 

d’individus à l’intérieur d’un même passage pour chaque taxon (Nmax) – un passage 

correspondant à la période comprise entre le moment d’apparition (in) et de sortie (out) 

d’un taxon dans le champ d’analyse. 

Le choix de l’approche dépendra des objectifs de l’étude et du niveau de complexité associé à 

l’annotation des passages et aux dénombrements répétés à l’intérieur de chaque passage 

(Nmax). L’annotation des passages (temps d’apparition et de sortie d’un taxon) et son 

dénombrement (Nmax, à l’intérieur de chaque passage), permettra d’évaluer le temps de 

résidence du taxon dans le champ d’analyse, et d’évaluer quantitativement l’impact d’un sous-

échantillonnage des séquences vidéo sur la perception d’abondance relative du taxon (Campbell 

et al. 2015). Cette approche peut cependant s’avérer laborieuse et exiger des investissements 

en temps importants dans le cas d’organismes mobiles présents en grands nombre, comme les 

crevettes. Il en revient donc au chargé de projet de déterminer laquelle des deux approches 

représente un gain d’information suffisant et intéressant par rapport au temps investi pour les 

analyses. Il est toutefois possible et suggéré d’utiliser l’une ou l’autre des deux approches pour 

dénombrer différents types d’organismes. Un exemple suggéré est de dénombrer les invertébrés 

avec l’approche MaxN et les poissons avec l’approche Nmax (voir section 2.7, Annexe 2). Dans 

ce cas, il est important que les dénombrements par passage (Nmax) demeurent complémentaires 

au suivi du MaxN pour chaque taxon sur toute la période d’analyse. 
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Figure 12. Décomptes et annotations d’organismes en stéréoscopie dans l’interface 
EventMeasure. A) dénombrement d’individus de morue franche (Gadus morhua) dans le vidéo 
de gauche : chaque individu est annoté d’un point (points jaunes sur l’image) et B) dénombrement 
de crabes commun (Cancer irroratus) visibles sur les deux vidéos, dont six individus marqués 
chacun d’un point sur l’image de gauche, et trois individus visibles uniquement sur la caméra 
droite, lesquels sont annotés d’un seul point sur la barre à appât. 

Le dénombrement des agrégations de spécimens (ex. bancs de poissons ou invertébrés 

présents en nombres élevés dans le champ d’analyse) est un défi courant en analyses vidéo. 

Lorsque les individus sont très nombreux, il devient difficile de les distinguer les uns des autres 

et réaliser un décompte visuel exact et précis(Schobernd et al. 2014; Stobart et al. 2015; 

Whitmarsh et al. 2017) Dans ces cas, une bonne pratique consiste à traiter les agrégations 

d’individus d’un même taxon comme des unités pour lesquelles un décompte approximatif est 

réalisé le plus rigoureusement possible. Une agrégation est définie comme l’occurrence 

simultanée de plusieurs spécimens d’un même taxon dans le champ d’analyse, en nombre 

suffisamment élevé pour différer lors de 3 décomptes distincts. En présence d’une agrégation 

de spécimens, il est suggéré d’annoter l’agrégation d’un seul point avec la mention « banc » ou 

« agrégation » en commentaires, et d’inscrire le nombre moyen d’individus obtenu à l’issue de 

trois décomptes distincts, avec la mention « + » (ex. 95+) (Figure 13). Il est important de ne pas 

confondre les agrégations avec les dénombrements difficiles en raison des conditions 

environnementales limitantes. Dans le cas des agrégations, seules l’abondance ou la densité 

élevée des spécimens à l’intérieur du champ d’analyse empêchent un dénombrement précis.  

https://www.seagis.com.au/event.html
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Figure 13. Décompte et annotation d’agrégations de spécimens dans l’interface EventMeasure : 
A) capelans (Mallotus villosus) avec un décompte moyen de 95 individus après trois décomptes 
indépendants, B) crevettes (Pandalidae) avec décompte moyen de 59 individus et C) ophiures 
(Ophiuroidea) avec un décompte moyen de 53 individus. La présence d’une agrégation est 
accompagnée d’un seul point/annotation sur le bras de la cage à appât, sur la vidéo de gauche. 

3.4.4. Mesures des organismes 

Échantillons photo en séquence 

Les mesures de longueur doivent être effectuées sur les photos calibrées (section 3.1.2). Pour 

l’étude de la structure de taille des populations, la méthode de mesures photogrammétriques en 

2D est moins précise que celle en 3D (mesures stéréoscopiques) puisque les angles des caméras 

par rapport au fond du quadrat et aux organismes ont une incidence sur l’exactitude et la précision 

des mesures (Harvey et al. 2002). Les mesures linéaires 2D sont néanmoins appropriées pour 

l’étude de certains organismes invertébrés tels que les pétoncles, dont l’angle de mesure des 

coquilles est généralement optimal en vue verticale plutôt qu’en vue oblique. Selon une étude 

chez les pétoncles, les spécimens mesurés à l’aide d’un vernier sur des spécimens physiques et 

les mesures réalisées sur des spécimens échantillonnés avec un système de caméras photo 

 

 

 

A 
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déposé calibré en bassin, sont similaires en termes d’exactitude et de précision sur les mesures 

(Stokesbury et al. 2014).   

L’abondance relative des organismes coloniaux et de la végétation aquatique submergée peut 

être mesurée en termes de superficie ou aire de couverture. Cette méthode consiste à définir 

des polygones dont les contours délimitent la surface occupée par le taxon. L’aire de 

recouvrement des polygones est ensuite mesurée (sur la photo calibrée de préférence) et peut 

être utilisée pour calculer le pourcentage de recouvrement par taxon et/ou morphotype (Figure 

14). L’usage d’un outil de sélection par seuils de couleurs peut grandement faciliter le travail de 

délimitation des polygones et le calcul des aires de recouvrement, notamment dans le cas des 

algues calcaires encroûtantes (genre Lithothamnion) et des zostères (Figure 15). Cet outil 

permet de sélectionner automatiquement les pixels correspondant à la plage de couleur, 

saturation et luminosité recherchée dans l’échantillon. La méthode de sélection par seuils de 

couleurs est généralement plus précise, mais son application est limitée. Le contraste des 

couleurs d’avant-plan et d’arrière-plan, entre l’organisme et son environnement, doit être 

suffisamment important pour que le logiciel puisse délimiter les contours. Les photos doivent 

avoir une bonne qualité visuelle. Une correction des photos pourrait être nécessaire, telle 

qu’une balance des blancs, pour augmenter les contrastes (voir procédure 1.5 en Annexe 1). 

Les données de superficie peuvent servir à générer des images de référence pour la création 

d’un guide visuel avec des exemples de pourcentage de couverture pour certains taxons, 

lorsque la qualité des photos est insuffisante ou qu’une définition manuelle des polygones est 

impraticable. Autrement, la méthode de superposition d’une grille (voir exemple Figure 11) pour 

l’estimation du pourcentage de couverture à l’aide des cellules peut être utilisée selon les 

besoins, en dénombrant le nombre de cellules où le taxon est présent (ex. Trygonis et Sini 

2012) ou en se basant sur des illustrations pour estimer le pourcentage de couverture (ex. 

Turner et al. 2016). 
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Figure 14. Délimitation de polygones servant à identifier et mesurer l’aire de recouvrement 
d’organismes coloniaux, tels que des coraux mous de l’ordre des Malacalcyonacea (Gersemia 
rubiformis ou Drifa glomerata) (interface Fiji avec la photo à analyser, la boîte de dialogue du ROI 
Manager et la liste des noms pour l’annotation des regroupements par morphotypes). 

https://fiji.sc/
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Figure 15. Sélection automatique d’une surface composée de zostères (gauche) et correspondant 
à des seuils basés sur la tonalité, la saturation et la brillance des couleurs (droite) dans l’interface 
du logiciel Fiji. 

Échantillons vidéo stéréoscopiques 

La stéréoscopie permet de mesurer avec précision les organismes et les composantes de 

l’habitat dans les échantillons d’imagerie. Contrairement aux repères visuels tels que les 

pointeurs laser, la stéréoscopie offre la possibilité de quantifier l’erreur et la précision des 

mesures. Ceci représente un avantage important, permettant de prendre en compte l’incertitude 

liée au mouvement et au positionnement des organismes dans le champ d’analyse, et son impact 

sur la précision des mesures. La quantification de l’erreur associée aux mesures est nécessaire 

à l’étude de la structure de taille des populations, et permet d’informer adéquatement les modèles 

de dynamique de populations paramétrés sur des classes de tailles. De plus, la stéréoscopie 

permet de mesurer les écarts de mesures  liés à l’échantillonnage, tels que le désalignement des 

caissons-caméras entre les déploiements, en utilisant les paramètres de calibration déterminés 

avant et après chaque mission (Harvey et Shortis 1998). En résumé, la stéréoscopie offre des 

avantages importants pour améliorer et optimiser la collecte de données sur la taille des 

organismes à partir des échantillons d’imagerie sous-marine.  

Une bonne pratique consiste à effectuer des mesures de taille, comme la longueur, de manière 

opportuniste sur tous les spécimens observés, du début à la fin de la période d’analyse, et de 

maximiser l’effort de mesure au MaxN de chaque taxon. Un effort de mesure supplémentaire au 

MaxN permet de maximiser le nombre d’individus distincts mesurés à l’intérieur de l’échantillon, 

https://fiji.sc/
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tout en réduisant la pseudoréplication. Seules les mesures de taille observées au MaxN de 

chaque espèce devraient être retenues dans l’échantillon final de mesures, de manière à éviter 

les biais causés par les mesures répétitives effectuées sur un même spécimen durant la période 

d’analyse (Hulls 2013; Unsworth et al. 2014; Díaz-Gil et al. 2017; Miller et al. 2017; SeaGIS 2019). 

Selon les objectifs de l’étude, des mesures répétitives peuvent être réalisées sur un même 

spécimen afin d’approfondir l’évaluation de la variation dans la précision des mesures.  

Les mesures sont effectuées seulement à l’intérieur du champ d’analyse stéréoscopique, en 

identifiant d’un point les extrémités de l’objet ou du spécimen sur les caméras de gauche et de 

droite. Certains logiciels utilisent un outil visuel (p. ex. ligne épipolaire dans EventMeasure), 

permettant à l’analyste de repérer facilement la position correspondant au même point dans les 

vidéos de gauche et de droite (Figure 16). Les organismes devraient être mesurés seulement 

lorsque certains critères sont respectés afin d’obtenir une précision suffisante. Ces critères de 

mesure suggérés sont 1) un positionnement perpendiculaire de l’organisme par rapport aux 

caméras, i.e., un angle de direction horizontale ne dépassant idéalement pas 45 degrés, 2) une 

posture la plus rectiligne possible du corps de l’organisme, i.e., ondulation minimale dans le cas 

des poissons; et 3) des extrémités bien définies (Langlois et al. 2021). Certains logiciels 

d’analyse offrent la possibilité d’activer des contraintes de mesures stéréoscopiques, lesquelles 

signalent automatiquement à l’analyste lorsque les critères de mesure ne sont pas remplis, et 

qu’une reprise de la mesure est nécessaire (voir procédure 2.4 en Annexe 2). Cette approche 

permet de faciliter le travail de l’analyste et d’assurer la qualité et la précision des mesures 

issues de l’échantillonnage vidéo. Dans certains cas particuliers, comme lors d’observations 

d’espèces rares, des mesures approximatives ne satisfaisant pas nécessairement les critères 

de mesure pourront être effectuées et incluses dans le jeu de données. Dans ces 

circonstances, la stéréoscopie a toujours l’avantage de permettre d’évaluer et rapporter 

quantitativement le degré d’incertitude (erreur et précision) associée à ces mesures. La 

distance des spécimens par rapport aux caméras influence aussi le potentiel de mesure. Miller 

et al. (2017) suggère que le potentiel de mesure diminue rapidement au-delà de 4 m en milieu 

marin (i.e., contours et extrémités moins bien définis). En effet, un effort de mesure réalisé sur 

plus de 2735 spécimens observés dans 278 échantillons vidéo en milieu estuarien (estuaire du 

Saint-Laurent), révèle que 99% des mesures ont été effectuées à 4 m et moins de distance des 

caméras (Tableau 8). La distance maximale pour la prise de mesures dépendra du type de 

caméra et  paramètres d’enregistrement utilisés, du système d’éclairage, et des conditions 

environnementales influençant la visibilité. Il est donc suggéré de travailler sans contrainte de 

distance lors de la prise de mesures.  

https://www.seagis.com.au/event.html#:~:text=SeaGIS%20EventMeasure%20EventMeasure%20-%20Event%20logging%20%26%203D,information%20and%20animal%20behaviour%20in%20underwater%20movie%20sequences.
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Figure 16. Étapes de la prise de mesure de longueur stéréoscopique (trait plein jaune) à l’aide de 
points 3D (croix jaune) et de la ligne épipolaire (trait pointillé jaune) dans le logiciel EventMeasure 
de SeaGIS sur un spécimen d’ogac (Gadus ogac). A) Positionnement du premier point de mesure 
sur le museau du poisson (gauche) et ligne épipolaire correspondante (droite). B) Positionnement 
du deuxième point de mesure sur la queue du poisson (gauche) et ligne épipolaire 
correspondante (droite). C) Ligne de mesure sur les deux caméras représentant une mesure de 
longueur totale. 

  

https://www.seagis.com.au/event.html#:~:text=SeaGIS%20EventMeasure%20EventMeasure%20-%20Event%20logging%20%26%203D,information%20and%20animal%20behaviour%20in%20underwater%20movie%20sequences.
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Tableau 8. Répartition de la fréquence des mesures de taille en fonction de la distance des 

organismes par rapport aux caméras, dans 278 échantillons vidéo CVSA acquis dans l’estuaire 

du Saint-Laurent (QC, Canada).  

Distance (m) Nombre de mesure 
(n) 

Pourcentage (%) 

0 > 1 663 24,2% 

1 > 2 1745 63,8% 

2 > 3 253 9,3% 

3 > 4 49 1,8% 

4 > 5 18 0,7% 

5 > 6 7 0,3% 

Total 2735 
 

 

Le Root Mean Square Error (RMSE) ou erreur quadratique moyenne est le paramètre de 

précision le plus utilisé en imagerie stéréoscopique (Xiong et Matthies 1997; Harvey et Shortis 

1998; SeaGis 2019; Langlois et al. 2020). Un RMSE de plus de 20 mm indique un problème dans 

l’alignement des points entre l’image de gauche et de droite au niveau de la ligne épipolaire, 

pouvant être causé par l’inclinaison d’une ou des deux caméras ou d’une mauvaise calibration 

(SeaGIS 2019). Le ratio de précision à la longueur (PLR — Precision to Length Ratio) est un 

autre paramètre couramment utilisé (Goetze et al. 2019; Langlois et al. 2020) pour valider 

certaines mesures. Il s’agit du rapport entre la valeur de précision (i.e., moyenne des écarts-types 

dans les trois dimensions de la mesure) et la valeur de longueur correspondante. Un PRL de plus 

de 10 % indique que la valeur de précision est trop faible par rapport à la taille de l’individu 

mesurée (Langlois et al. 2020). 

La prise de mesures en imagerie sous-marine demeure un défi dont la précision est influencée 

par la capacité de l’analyste à repérer les extrémités de l’organisme dans différentes conditions 

d’échantillonnage, et par la morphologie et le comportement des taxons observés (López-

Macías et al. 2023). Le choix du type de mesure de longueur à effectuer doit tenir compte à la 

fois des particularités morphologiques de chaque taxon (Holden et Raitt 1974), de leur motilité 

et de la résolution des images. Pour les séquences vidéo, certaines études recommandent 

d’effectuer des mesures de longueur à la fourche chez les poissons. En effet, la position du 

centre de la fourche de la nageoire caudale est généralement plus facile à localiser que 

l’extrémité de la nageoire caudale, cette dernière étant nécessaire pour mesurer la longueur 

totale (Langlois et al. 2020). La nageoire caudale peut être compressée le long de l’axe 

longitudinal, en raison du mouvement ondulatoire, et ainsi influencer la mesure de la longueur 

totale (López-Macías et al. 2023). Or, d’autres types de mesures peuvent s’avérer appropriés et 

préférables pour certaines espèces, par exemple la longueur standard pour le tricorne arctique 

(Gymnocanthus tricuspis) dont la nageoire caudale est généralement transparente (Figure 17), 

ou la longueur précaudale des grands requins (Carcharodon carcharias) (Harasti et al. 2016). 

Une approche flexible permettant à l’analyste de considérer le type de mesure généralement 

préconisé pour chaque espèce, la nécessité d’adapter la prise de mesure au contexte particulier 

de l’imagerie sous-marine et la disponibilité de relations de conversions (empiriques ou 

théoriques) entre les différents types de mesures pour une espèce donnée, est donc 

recommandée. L’important sera de s’assurer la traçabilité du type de mesure effectuée à l’aide 

d’une annotation systématique. La Figure 17 et la Figure 18 montrent différents types de 
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mesures effectuées sur des taxons de poissons et invertébrés, respectivement, sur échantillons 

vidéo stéréoscopiques (voir procédure A2.7.2 en Annexe 2 pour informations et 

recommandations additionnelles).  

 

Figure 17. Différents types de mesures effectuées sur des poissons en imagerie sous-marine 
stéréoscopique, dans l’estuaire et le golfe du Saint-Laurent (Qc, Canada) : A) mesure de la 
longueur totale d’une morue franche Gadus morhua, B) mesure de la longueur standard d’un 
tricorne arctique Gymnocanthus tricuspis, C) mesure de la longueur à la fourche d’un stromatée 
à fossettes Peprilus triacanthus et D) mesure de la longueur standard d’un maquereau bleu 
Scomber scombrus. Voir Tableau A2.3 en Annexe 2 pour la définition des différents types de 
longueurs pour les poissons. 
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Figure 18. Différents types de mesures effectuées sur des taxons d’invertébrés en imagerie sous-
marine stéréoscopique, dans l’estuaire et le golfe du Saint-Laurent (Qc, Canada) : A) largeur de 
la carapace chez le crabe des neiges (Chionoecetes opilio), B) longueur du céphalothorax chez 
le homard Homarus americanus, C) diamètre du test chez l’oursin Strongylocentrotus sp. et D) 
longueur de la coquille chez le buccin Buccinum sp. Voir Tableau A2.4 en Annexe 2 pour la 
définition des différents types de longueurs pour les espèces d’invertébrés. 
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3.4.5. Données comportementales (échantillons vidéo seulement) 

L’échantillonnage et les analyses vidéo peuvent être utilisés pour la récolte de données 

comportementales sur les espèces aquatiques. Des comportements individuels de prédation, 

d’alimentation, de fuite et d’enfouissement sont souvent observés dans les séquences vidéo, de 

même que des interactions intra- et interspécifiques. Le comportement des organismes par 

rapport à l’appât dans les systèmes appâtés peut être documenté en déterminant le temps de 

première arrivée de chaque espèce/taxon, et en calculant la distance minimale d’approche à 

l’aide de mesures en 3D (Langlois et al. 2020). La présence et le choix de l’appât auront pour 

effet d’attirer certaines espèces mobiles plus que d’autres (ex. prédateurs et charognards). Les 

comportements liés à la présence d’un appât dépendront du panache de dispersion de celui-ci 

(direction, amplitude), et d’un ensemble d’autres facteurs dont les conditions locales de courant 

et les caractéristiques intrinsèques des différences espèces (Whitmarsh et al. 2017). 

L’usage de lampes sous-marines influence le comportement de certaines espèces, en les attirant 

ou en les éloignant du dispositif d’imagerie sous-marine (i.e., phototaxie positive ou négative). Le 

choix de la longueur d’onde utilisée pour l’éclairage artificiel (ex., lumière rouge, blanche ou jaune) 

aura une influence plus ou moins grande sur le comportement des différents organismes, selon 

que l’échantillonnage soit réalisé en zone photique ou aphotique (Harvey et al. 2012; Birt et al. 

2019). Des organismes comme le zooplancton peuvent être attirés par la lumière des lampes 

autour d’un appât, ce qui peut entraîner une cascade trophique i.e., présence successive de 

proies et de prédateurs (Birt et al. 2019). Harvey et al. (2012) ont démontré que le zooplancton 

était fortement attiré par la lumière blanche (par comparaison à la lumière rouge), et que 

l’abondance de deux espèces de poissons était corrélée à celle du zooplancton. L’agrégation de 

spécimens autour de l’appât et des lumières peuvent occasionnellement réduire le champ visuel 

et limiter la détection d’autres organismes présents sur le site d’échantillonnage (voir exemple 

Figure 3A) (Harvey et al. 2012).  

Les données de comportements seront spécifiques aux paramètres et à la configuration du 

système de caméra utilisé pour la collecte des échantillons vidéo. Le potentiel d’utilisation des 

échantillons d’imagerie en biologie comportementale est important et varié (Chidami et al. 2007; 

Dahms et Hwang 2010; Mensinger et al. 2016). Afin d’encourager le développement d’études 

comportementales à partir des analyses d’échantillons vidéo, il est suggéré d’annoter tous 

comportements avérés pendant la période d’analyse, leur nature (ex. prédation) et portée (ex. 

interaction intra- ou interspécifique), de manière factuelle et sans interprétation (ex. en nommant 

le ou les taxons impliqués et l’action observée). Des exemples d’annotations factuelles de 

comportements sont présentées à l’Annexe 2 (section 2.7, Figure A2.26). 

3.5. OPTIMISATION DES ANALYSES D’IMAGERIE 

L’analyse d’échantillons photo et vidéo pour l’extraction de données bioécologiques peut être 

coûteuse, longue et fastidieuse. Le temps nécessaire pour analyser les images est une contrainte 

importante à la création de séries temporelles à partir de relevés d’imagerie sous-marine (Bowden 

et al. 2020). Le temps d’analyse varie en fonction du plan d’échantillonnage, du protocole et du 

logiciel utilisé pour les analyses, de l’expérience des analystes, ainsi que de la complexité de 

l’habitat et de la communauté échantillonnée. La quantité et la diversité des annotations 

influencent également le temps d’analyse (ex. Terrill 2021; Costa et al. 2022 pour l’annotation 

d’objets par point), alors que l’identification taxonomique peut représenter une fraction importante 

du temps requis pour le traitement des échantillons. L’accès à un guide ou à des clés 

d’identification taxonomique spécialement dédiées à l’imagerie sous-marine pour une région 
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d’étude donnée, peut grandement réduire l’investissement en temps nécessaire à l’identification 

taxonomique et limiter les sources d’erreurs (Hanafi-Portier et al. 2021).  

La procédure d’analyse photos en séquence proposée dans ce rapport, appliquée aux 

échantillons photos issus de 1768 déploiements d’un système CPD dans une zone côtière (0-50 

m de profondeur) de l’estuaire du Saint-Laurent, demande un temps de traitement moyen de 30 

minutes par déploiement (min-max : 11-40 min/déploiement CPD). Ce chiffre correspond à 

l’extraction des données brutes, incluant le temps pour la préparation des photos, les validations 

taxonomiques et les analyses de biodiversité (dénombrement et superficie) et du substrat à l’aide 

du logiciel Fiji de ImageJ. Le temps pour préparer les séquences de photos appariées (caméras 

en vue verticale et vue oblique) est d’environ 5 minutes par déploiement alors que le temps requis 

pour le processus de validation taxonomique peut représenter de 15 à 35 % du temps nécessaire 

pour les analyses, selon l’expérience de l’analyste et la diversité des sites échantillonnés.  

La procédure d’analyse vidéo détaillée dans ce rapport vise à extraire un maximum d’informations 

et données biologiques et écologiques afin de répondre à diverses questions de recherche. 

Appliquée aux échantillons vidéo issus de 75 déploiements d’un système CVSA dans une zone 

côtière (10 à 50 m de profondeur) dans l’estuaire du Saint-Laurent, cette procédure exhaustive, 

réalisée manuellement à l’aide du logiciel EventMeasure, demande en moyenne un ratio temps 

d’analyse par heure d’enregistrement vidéo de 2,5 :1 (min-max 0,4-4,5; pour des déploiements 

d’une durée moyenne de 100 minutes).  

L’utilisation de l’intelligence artificielle (IA) et apprentissage machine offrent des gains d'efficacité 
potentiellement énormes. Le développement d’outils autonomes ou semi-autonomes est une des 
principales avenues pour l’optimisation des analyses d’imagerie sous-marine. Le développement 
de ces outils consiste à entraîner des algorithmes pour la détection, la classification, et le 
dénombrement de différents types d’organismes et/ou paramètres d’habitat, un processus qui 
nécessite la création et un accès efficace à des banques d’images volumineuses. Une autre 
option est d’utiliser un modèle déjà entrainé et de l’adapter au contexte de l’étude. Une étude 
ayant testé différentes plateformes d’analyses photo couplées à l’intelligence artificielle pour la 
classification des substrats benthiques, a permis d’identifier 4 logiciels ou applications web 
pouvant servir au développement de programmes semi-automatisés en support à l’imagerie 
benthique (Costa et al. 2022). Divers outils d’intelligence artificielle existent ou sont actuellement 
développés dans le but d’automatiser l’extraction de données biologiques et écologiques à partir 
d’échantillons vidéo (Villon et al. 2018; Allken et al. 2019; Salman et al. 2020; Connolly et al. 
2021; Lopez‐Marcano et al. 2021; Knausgård et al. 2022; Marrable et al. 2022). La plateforme en 
développement AFID (Automated Fish Identification) devrait permettre d’automatiser 
progressivement les identifications, dénombrements, et mesures dans EventMeasure. De 
manière générale, les algorithmes de dénombrement performent bien (Connolly et al. 2021), alors 
que la performance des algorithmes de détection et d’identification varie grandement selon le 
type d’habitat échantillonné (Ditria et al. 2020), les conditions de luminosité, la forme corporelle, 
l’orientation, et le mouvement des organismes échantillonnés, et la présence de végétation 
aquatique submergée et autres structures physiques sur le fond marin (Salman et al. 2020). La 
détection d’une espèce en particulier à l’intérieur d’un assemblage multiespèces est possible et 
a été démontrée (Lopez‐Marcano et al. 2021). À l’heure actuelle, le frein principal du 
développement et de l’application des outils et techniques automatisés en analyses d’imagerie, 
est la disponibilité des données d’entraînement en quantité suffisante et représentative des 
différents milieux et assemblages d’espèces échantillonnés (Allken et al. 2019). Des initiatives en 
source ouverte telle FathomNet et iNaturalist facilitent déjà l’entraînement et la validation 
d’algorithmes de détection et d’identification de grands groupes taxonomiques (Katija et al. 2022) 

https://fiji.sc/
https://www.seagis.com.au/event.html
https://www.afid.io/presentation
https://fathomnet.org/fathomnet/#/
https://www.inaturalist.org/
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Un avantage important des outils d’IA est la quantification de l’erreur associée aux processus de 
détection, reconnaissance, et classification des organismes dans le traitement des images. Cet 
aspect permettra d’améliorer le contrôle de qualité des données d’imagerie, et de générer des 
données fiables et reproductibles. L'utilisation de l'apprentissage machine devrait accélérer 
l'extraction des données et réduire les délais et les coûts liés au traitement des échantillons 
d'imagerie. Cependant, à court ou moyen terme, il demeure crucial de maintenir une équipe 
d'analystes et de taxonomistes expérimentée pour garantir un contrôle de qualité des données 
générées automatiquement. Par exemple, Boom et al. (2014) ont souligné l'importance d'une 
supervision humaine pour assurer la fiabilité des résultats automatisés dans l'analyse continue 
des assemblages de poissons à partir de séquences vidéo sous-marines. 

4. CONCLUSION 

La standardisation des procédures d’analyse en imagerie sous-marine est essentielle afin 
d’assurer la cohérence des données biologiques et écologiques récoltées avec différents 
dispositifs d’échantillonnage, dans différents milieux ou habitats, et dans le contexte de relevés 
annuels ou saisonniers. Diverses approches d’annotation et paramètres standards ont vu le jour 
au cours des dernières décennies, la plupart visant l’atteinte d’objectifs spécifiques dans des 
environnements particuliers. L’application d’un ensemble de bonnes pratiques et de procédures 
interopérables pour le traitement d’échantillons photo et vidéo récoltés à partir de systèmes 
complémentaires d’imagerie fixes ou déposés, permettra de maximiser la qualité, la quantité, et 
la diversité des données recueillies dans les échantillons d’imagerie. Ces bonnes pratiques et 
ces procédures sont applicables à la plupart des environnements marins et échantillons photo ou 
vidéo issus de divers dispositifs d’échantillonnage visuel. Leur application permettra de générer 
des données fiables et comparables accompagnées d’erreurs quantifiables qui serviront, entre 
autres, à explorer les liens entre les conditions environnementales, la structure des habitats, et la 
composition des assemblages biologiques; à l’évaluation de la performance des méthodes 
visuelles par rapport aux méthodes d’échantillonnage conventionnelles comme les relevés au 
chalut ou acoustiques; à investiguer les conditions et paramètres environnementaux ayant une 
incidence sur la détection des méthodes visuelles; et à déterminer si un sous-échantillonnage 
des séquences photo et vidéo pourrait permettre de générer des données précises tout en 
réduisant le temps d’analyse. Les méthodes d’annotation proposées faciliteront la création de 
banques d’images de référence pouvant servir à l’entraînement d’algorithmes de détection et de 
classification des organismes et habitats marins. Le développement d’outils semi-automatisés ou 
automatisés permettra des gains d’efficacité substantiels à court et moyen terme pour l’acquisition 
des données d’imagerie. La mise en œuvre des bonnes pratiques proposées dans ce rapport 
permettra de consolider la contribution des méthodes d’échantillonnage visuel à la gestion 
écosystémique des stocks halieutiques, de la biodiversité, et des habitats marins. 
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ANNEXE 1 : PROCÉDURES D’ANALYSES DES SÉQUENCES 
PHOTO AVEC FIJI 

 
1.1 Organisation et nomenclature des fichiers 
 
1. Sur le terrain, sauvegarder les photos brutes dans des dossiers de manière à classer les 

déploiements par date, par engin et par caméra lors des missions. Cette étape constitue un 
pré-triage seulement et peut être omise si l’horaire permet de faire directement le classement 
final à l’étape 2. 

2. Lorsque le temps le permet, soit sur le terrain ou au retour de la mission en mer, effectuer le 
classement et le renommage final. Classer les fichiers photo par séquence dans des dossiers 
renommés selon l’OpCode. 

a. Créer la liste des identifiants uniques à partir des métadonnées de chaque 
déploiement CPD (OpCode), comme dans le Tableau 1. 

b. Utiliser cette liste pour créer des dossiers pour chaque déploiement, à l’aide d’un 
logiciel (ex. Text to folder). 

c. Placer une copie des dossiers d’OpCode créés au point b dans deux nouveaux 
dossiers nommé selon le code de la caméra (i.e., un pour les photos en vue verticale 
(caméra rouge, R) et un autre pour la vue oblique (caméra verte, V)). 

d. Regrouper les dossiers de déploiements/code de caméra par station et les dossiers 
de station par mission. 

e. Une fois tous les dossiers créés, classer les photos en séquence pour tous les 
déploiements dans leur dossier respectif. 

3. Renommer les photos à l’aide d’un logiciel (ex. Bulk rename utility). 
a. Nommer chaque photo selon le nom du dossier et ajouter un numéro séquentiel de 

manière à ce que chaque photo puisse avoir un identifiant unique (ex. Photo_ID). 
b. Se référer à l’exemple de nomenclature des photos en séquence pour un déploiement 

à la Figure A1.1. 
 

https://www.dcmembers.com/skwire/download/text-2-folders/
https://www.bulkrenameutility.co.uk/
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Figure A1.1. Exemple de la structure d’archivage et de la nomenclature des photos d’un 
déploiement CPD (ex. IML-2022-025_045_CPD-1-1_20220702_1603): Séquence de photos de 
la caméra A) en vue verticale (rouge) et B) en vue oblique (verte). La photo sélectionnée et copiée 
pour les annotations est en surbrillance en bleu. 
  

A 

B 
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1.2 Visionnement préliminaire et qualité des photos 
 
1. Ouvrir le dossier du déploiement CPD et visualiser toutes les photos de la séquence en vue 

verticale et la séquence en vue oblique, préalablement renommée (Figure A1.1) 
2. Sélectionner la photo ayant la meilleure visibilité (résolution et clarté de l’eau) 

a. Pour la séquence de la caméra en vue verticale, sélectionner la photo principale du 
déploiement sur laquelle pourront être effectuées les annotations lors des analyses de 
la biodiversité et du substrat 

b. Pour la séquence de la caméra en vue oblique, sélectionner la photo secondaire du 
déploiement 

c. Créer une copie de chaque photo sélectionnée et les renommer selon le nom du 
dossier de la séquence, tel que présenté dans la Figure A1.1 

3. Évaluer la qualité des photos en séquence et attribuer une cote de qualité visuelle pour 
chaque déploiement, selon différents facteurs : 

a. Attribuer une cote de visibilité, en termes de résolution et de clarté de l’eau, pour la 
photo principale et secondaire préalablement sélectionnée (Tableau 2 et Figure 1) 

b. S’il y a un problème important affectant le champ visuel du système CPD (Tableau 3), 
soustraire 1 unité à la cote de visibilité de la photo sélectionnée 

c. Si la séquence compte moins de 4 photos stables (équivalent à 40 secondes au fond, 
dans la même position), soustraire 1 unité 

d. Si la séquence en vue verticale ne compte que 1 photo stable (dans la même position), 
le déploiement est considéré comme nul et il faut inscrire 0 comme cote de qualité du 
déploiement 

e. Répéter les étapes a à d pour la photo secondaire  
f. Inscrire la cote de qualité finale dans la base de données relationnelle associée aux 

déploiements CPD. Il est aussi suggéré d’associé la cote de qualité de la séquence 
aux photo principales et secondaires en utilisant le système d’étoiles accessible avec 
un clic du bouton droit de la souris suivi de Détails > Classification. 

4. Noter également les informations concernant les problèmes liés au champ visuel du système 
CPD dans la base de données (ex. lampe éteinte, obstruction des caméras) 

5. Identifier les déploiements avec les photos ou les séquences nulles afin de les éliminer du 
processus d’analyse; noter NUL comme statut dans la base de données. 

 
1.3 Importation des photos et outils d’annotation avec Fiji 
 
Importation des photos 
 
1. Ouvrir Fiji pour voir apparaître l’interface principale (Figure A1.2). 
2. Ouvrir une séquence de photos à partir de l’interface. 

a. Cliquer sur File > Import > Image sequence. 
b. Cliquer sur Browse de la boîte de dialogue (Figure A1.3) et sélectionner le dossier de 

la séquence du déploiement. 
c. Cliquer sur OK pour voir la séquence de photos apparaître. 

3. Visualiser les photos de la séquence en mouvement en cliquant sur la séquence de photos 
et utiliser la molette de la souris (déroulement de haut en bas). 

4. Ajuster le zoom des photos en maintenant la touche CTRL et utiliser la molette de la souris 
(déroulement de haut en bas). 
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Figure A1.2. Interface principale de Fiji. 
 

 
Figure A1.3. Importation d’une séquence de photos dans Fiji. 
 
5. Ouvrir une seule photo. 

a. Cliquer sur File > Open. 
b. Sélectionner la photo (ex. IML-2021_050_BC09_CPD-PC-3_20211019_1514.JPG) 

dans le dossier de la séquence du déploiement et cliquer sur Ouvrir. 
 
Outils d’annotation (Points et mesures 2D) 
 
1. Ouvrir la boîte de dialogue pour effectuer des annotations avec les ROIs (Region of interest) 

à partir de l’interface de Fiji en cliquant sur Analyze > Tools > ROI Manager. 
2. Ajouter un point d’annotation 2D, sélectionner l’outil d’annotation Multipoints à partir 

de l’interface principale (voir procédure 1.7 – Dénombrements pour un exemple). 
3. Effectuer une mesure de surface en 2D (aire de couverture), sélectionner l’outil de mesure 

Polygon ou l’outil de sélection FreeHand  à partir de l’interface 
principale (voir procédure 1.7- Mesures de surface 2D 

pour un exemple). 
4. Effectuer une mesure linéaire 2D (longueur), sélectionner l’outil de mesure Straight line sur 

l’interface principale (voir procédure 1.7- Mesures linéaires 2D pour un exemple). 
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1.4 Correction des photos avec Fiji 
 
1. Effectuer la balance des blancs. 

a. Télécharger la macro White balance correction_1.0.ijim.  
b. Dans Fiji, cliquer sur Plugins > Macros > Install, puis sélectionner le fichier White 

balance correction_1.0.ijm 
c. Importer la photo à corriger. 
d. Cliquer sur White balance correction_1.0.ijm et sur Ouvrir afin qu’une boîte de dialogue 

apparaisse. 
e. Sélectionner la région comprenant tout le quadrat et cliquer sur OK. 
f. Enregistrer la photo corrigée (Figure A1.4) dans le dossier du déploiement. 

Figure A1.4. Image avant (gauche) et après (droite) la balance des blancs avec Fiji. 
 
1.5 Calibration des photos avec Fiji 
 
Calibration de l’échelle de mesure à partir de photos récoltées sur le terrain 
 
1. Calibrer le logiciel pour chaque engin, à partir des photos récoltées sur le terrain. 

a. Sélectionner des photos de différents déploiements CPD (au moins 3 par mission). 
b. À l’aide de l’outil de mesure Straight line, mesurer la distance en pixel des 4 côtés 

intérieurs du quadrat et saisir l’information (apparaissant sur la barre de l’interface) dans 
un tableau de données créé à cet effet. 

c. Calculer la valeur moyenne en pixel pour représenter la distance connue de 500 mm. 
d. Calculer l’écart-type et le coefficient de variation afin de déterminer si la photo est linéaire 

(aplanie) ou s’il y a distorsion. 
e. S’il y a de la distorsion dans la photo, causée par la lentille/paramètres, l’angle ou la 

position de la caméra, le coefficient de variation peut être important (>1%). Dans tous les 
cas, il est recommandé de quantifier l’erreur sur les mesures pour chaque engin en bassin 
(voir section 1.5 Calibration en bassin). 

2. Calibrer l’outil de mesure pour les photos. 
a. Cliquer sur Analyze > Set Scale. 
b. Entrer les informations concernant la distance en pixel, la distance connue, le ratio de 

pixel (Pixel aspect ratio = 1.0), l’unité de mesure (Unit of length = mm) et 
cocher Global  (Figure A1.5) et cliquer OK. 

https://github.com/pmascalchi/ImageJ_Auto-white-balance-correction


58 
 

 
Figure A1.5. Calibration de l’échelle de mesure en nombre de pixels par unité de longueur (ex. 
mm) sur Fiji. 
 
3. Ajouter une barre de mesure aux photos. 

a. Ouvrir Analyze > Tools > Scale bar. 
b. Entrer la largeur désirée dans Width in mm : 4. 
c. Entrer la hauteur désirée dans Height in mm : 4. 
d. Conserver les autres valeurs par défaut (Figure A1.6). 
e. Cliquer sur OK pour voir la barre apparaître au bas à droite de la photo (Figure A1.7). 

 

 
Figure A1.6. Ajustement de la barre d’échelle sur Fiji. 
 
4. Vérifier la taille des particules avec le pointeur de la souris. 

a. Ajuster le zoom de la photo jusqu’à un grossissement de 100 %. 
b. Sélectionner par la suite l’outil Multipoints tool et double-cliquer sur le bouton de gauche 

de la souris ; sélectionner Type : Hybrid et Size : Large. À un grossissement de 100 % de 
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la photo, la largeur du curseur est égale à 4 mm sur l’échelle et la moitié du curseur 
représente 2 mm (l’équivalent de la gamme de taille d’une granule soit 2 à < 4 mm) (Figure 
A1.7). 

 

 
Figure A1.7. Boîte de dialogue de l’outil de pointage Multipoint avec sélection du type « hybride » 
et « Large » (droite) et barre de l’échelle de 4 mm servant de comparatif pour la taille du pointeur 
de la souris sur le logiciel Fiji (gauche). 
 
Calibration de l’échelle de mesure en bassin 
 
1. Pour chaque engin, il est recommandé de prendre des photos en bassin afin de calibrer 

l’échelle de mesure du système CPD et de mesurer la distorsion des photos, causée par la 
lentille/paramètres, l’angle ou la position de la caméra verticale. 
a. Fixer une surface rigide (ex. plexiglass) avec un motif en damier (ex. impression d’un 

patron d’échiquier) sous le quadrat d’échantillonnage (50 x 50 cm). 
b. Immerger le système CPD et prendre des photos selon les paramètres d’enregistrement 

prédéfinis. 
2. Effectuer plusieurs mesures sur la photo, à l’aide du logiciel Fiji. 

a. Calibrer d’abord l’échelle de mesure (ratio pixel/mm), tel que présenté dans les étapes 1 
et 2 de la section précédente 1.5 Calibration « in situ ». 

b. Sélectionner aléatoirement 3-5 cellules de la grille quadrillée et mesurer des combinaisons 
de cellules (ex 1 cellule, 3 cellules, 5 cellules) dans les orientations verticales et 
horizontales. Faire de même pour différentes mesures de surface des cellules. 

c. Calculer le pourcentage d’erreur et le coefficient de variation sur les mesures de cellules 
d’une même combinaison. 

d. Comparer les mesures au centre et aux extrémités de la photo, pour déterminer la 
présence de distorsion. 

e. Si c’est possible, remédier aux problèmes de distorsions causés par la lentille/paramètres, 
l’angle ou la position de la caméra. 

  

https://github.com/opencv/opencv/blob/4.x/doc/pattern.png
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1.6 Analyse du substrat avec Fiji 
 
1. Mettre en place la grille sur la photo principale (Figure A1.8). 

a. Ouvrir Analyze > Tools > Grid. 
b. Dans la boîte de dialogue, modifier Area per point et inscrire la valeur de l’aire en mm2 qui 

permet la distribution équidistante de 49 points à l’intérieur du quadrat d’échantillonnage 
(ex. 4000 mm2 pour un système CPD calibré pour une mission).  

c. Conserver les autres valeurs par défaut. 
d. Cliquer sur OK. 

  

 
Figure A1.8. Ajout d’une grille sur la photo d’analyse pour la caractérisation du substrat. 
 
2. Créer un jeu de données contenant 49 points équidistants répartis aux intersections de la 

grille, à l’intérieur du quadrat d’échantillonnage de chaque engin calibré (Figure A1.9). 
a. Cliquer sur l'outil MultiPoints au niveau de l’interface de Fiji et ajouter un point légèrement 

en haut et à droite de chaque intersection jusqu’à l’obtention de 49 points équidistants.  
b. Cliquer sur Add dans la boîte de dialogue de ROI Manager accessible dans le menu 

Analyze > Tools. 
c. Sélectionner le ROI nouvellement créé et cliquer sur Rename.  
d. Nommer le ROI en fonction du code de l’engin calibré (ex. 49 points_CPD_RV1) et cliquer 

sur OK. 
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a. Enregistrer le fichier ZIP en cliquant sur More > Save et nommer le fichier selon l’engin 
calibré (ex. 49 points_CPD_RV1.roi). 

b. Conserver ce jeu de données pour les analyses subséquentes du substrat. 
 

 
Figure A1.9. Création d'un jeu de données contenant 49 points équidistants répartis aux 
intersections de la grille, à l’intérieur du quadrat d’échantillonnage pour chaque engin calibré, à 
l’aide de l’outil Multipoints et de la fonction ROI Manager. 
 
3. Télécharger le jeu de données 49points.roi pour chaque déploiement à analyser, selon l’engin 

déployé et calibré. 
f. Ouvrir Analyze > Tools > ROI Manager. 
g. Cliquer sur More > Open. 
h. Sélectionner le fichier 49points.roi conservé dans le dossier de la séquence du 

déploiement CPD selon l’engin calibré. 
i. Cliquer sur le ROI 49 points (le nom s’affiche en bleu) pour voir les points apparaître 

devant les 49 intersections, légèrement en haut et à droite de l’intersection, dans le coin 
du carré.  

j. Dans le cas où un organisme cache le substrat, déplacer le point du curseur vers la droite 
jusqu’au substrat le plus près, mais à l’intérieur du même carré. Lorsqu’il est impossible 
de voir le substrat dans le carré, le point sera alors modifié et classé comme substrat 
inconnu. 

4. Évaluer la taille des particules et renommer les 49 points selon la catégorie du substrat. 
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a. Ouvrir un chiffrier contenant la base de données pour une mission et la liste des catégories 
du substrat superficiel (Tableau 7). 

b. Utiliser l’outil de mesure linéaire Straight line pour mesurer les particules ou se référer à 
la taille du curseur de l’outil Multipoints ou de la grille pour évaluer la taille des particules 
(Figure A1.7). 

c. Pour renommer le ROI 49points selon une catégorie de substrat, cliquer sur le nom pour 
le mettre en surbrillance et cliquer sur Rename. 

d. Copier-coller le nouveau nom de la catégorie de substrat selon la taille des particules dans 
le quadrat (ex. Pebble (2 < 64 mm)) et cliquer sur OK. 

e. Supprimer tous les points n’appartenant pas à la catégorie de substrat mesurée. Pour 
supprimer un point dans un ROI multipoints, activer le ROI en cliquant dessus (il devient 
bleu), placer le curseur avec la main blanche devant le point à supprimer parmi les 49, 
appuyer sur la touche Control du clavier et cliquer sur le bouton de gauche de la souris, 
le point disparaît; cliquer sur Update. 

f. Créer un nouveau ROI correspondant à une autre catégorie de substrat présente parmi 
les 49 points. Pour créer un nouveau ROI, désélectionner le ROI qui est actif en bleu en 
appuyant sur Deselect et sélectionner show all, puis désélectionner la case. 

g. Cliquer à une intersection correspondante à la catégorie de substrat mesurée pour ajouter 
un nouveau point ROI et cliquer sur add; renommer le nouveau ROI selon la catégorie de 
substrat mesurée (voir exemple  

h. Figure 8. ). 
i. Répéter les étapes e-g jusqu’à ce que les 49 points aient été attribués à une catégorie de 

substrat. 
5. Enregistrer le fichier ZIP. 

a. Par la suite, enregistrer le fichier ZIP selon le nom de la photo analysée en cliquant sur 
More > Save. 

b. Nommer le fichier comme suit : selon l’OpCode et ajouter le détail SUB et terminer par le 
nom d'extension du fichier .zip (ex. IML-2021_050_BC09_CPD-PC-
3_20211019_1514_Sub.zip). 

6. Extraire les données des 49 points avec la somme par catégorie du substrat (Figure A1.10). 
a. Cliquer sur More > List et un tableau Overlay Elements apparaît. 
a. Cliquer sur File > Save as et enregistrer le tableau sous un .csv. Ouvrir le .csv dans Excel 

et transférer l’onglet dans le fichier de compilation de la mission (ex. IML-2022-
025_CPD_SUB.xlsx). 

b. Utiliser la colonne Name pour associer les catégories du substrat superficiel annoté et le 
nombre de points total comptabilisé dans la colonne Points. 

 

 
Figure A1.10. Extraction des données des 49 points, avec la somme pour chaque catégorie de 
substrat superficiel annoté, pour un déploiement CPD. 
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7. Extraire les données pour chacun des 49 points annotés avec leurs coordonnées (Optionnel, 
Figure A1.11). 
a. Cliquer sur Measure et un tableau Results apparaît. 
b. Cliquer sur File > Save as et enregistrer le tableau sous un .csv. Ouvrir le .csv dans Excel 

et transférer l’onglet dans le fichier de compilation de la mission (ex. IML-2022-
025_CPD_SUB.xlsx). 

c. Utiliser la colonne Label pour associer la catégorie du substrat superficiel annoté et leurs 
coordonnées X et Y pour chaque point. 

 

 
Figure A1.11. Exemple d’une extraction des données pour quelques points des 49 points annotés 
avec le nom de la catégorie du substrat et leurs coordonnées X et Y. 
 
1.7 Analyse de la biodiversité avec Fiji 
 
Dénombrements 
 
1. Importer une séquence de photos à analyser. 
2. Créer un jeu de données de multipoints contenant les points d’annotation des organismes 

a. Cliquer sur l'outil MultiPoints. 
b. Ouvrir Analyze > Tools > ROI Manager (Note: Roi Manager sert à faire des annotations 

et à créer un jeu de données associé). 
c. Cliquer sur tous les individus d’un taxon afin de leur ajouter un point.  
d. Cliquer sur Add. 
e. Cliquer sur le ROI nouvellement créé et cliquer sur Rename.  
f. Nommer le ROI en fonction du taxon identifié (TOUJOURS copier-coller le nom du taxon 

à partir de la liste de taxons et morphotypes acceptée) ( 
g. Figure 10) et cliquer sur OK. 
h. Pour créer un nouvel ROI pour un autre taxon, désélectionner le ROI actif en bleu en 

appuyant sur Deselect et sélectionner puis désélectionner la case show all. 
i. Répéter les étapes c-h pour chaque taxon. 
j. Pour supprimer un point d’un ROI multipoint, activer le ROI avec un simple clic (il devient 

bleu), placer le curseur avec la main blanche devant le point à supprimer, appuyer sur la 
touche Control du clavier et cliquer sur le bouton de gauche de la souris, le point disparaît); 
cliquer sur Update. 

3. Enregistrer le fichier ZIP. 
c. Enregistrer le fichier ZIP selon le nom de la photo en cliquant sur More > Save. 
d. Nommer le fichier selon le OpCode, ajouter le suffixe Bio et l’extension .zip (ex. IML-

2021_050_BC09_CPD-PC-3_20211019_1514_Bio.zip). 
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4. Extraire les données de biodiversité des ROI multipoints et la somme des données par 
identifiant taxonomique (Figure A1.12). 
a. Cliquer sur More > List et un tableau Overlay Elements apparaît.  
b. Cliquer sur File > Save as et enregistrer le tableau sous un .csv. Ouvrir le .csv dans Excel 

et transférer l’onglet dans le fichier de compilation de la mission ex. IML-2022-
025_CPD_BIO.xlsx). 

 

 
Figure A1.12. Extraction des données de points annotés, avec la somme pour chaque identifiant 
taxonomique, pour un déploiement CPD. 
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5. Extraire les données de biodiversité de ROI multipoints pour chacun des points annotés 
(individu) avec leurs coordonnées (optionnel). 
a. Cliquer sur Measure et un tableau Results apparaît. 
b. Cliquer sur File > Save as et enregistrer le tableau sous un .csv. Ouvrir le .csv dans Excel 

et transférer l’onglet dans le fichier correspondant. 
c. Utiliser la colonne Label pour associer l’identifiant taxonomique annoté et leurs 

coordonnées X et Y pour chaque point. 
6. Estimer les organismes trop nombreux pour être comptés (banc). 

a. Utiliser la séquence de photos pour l’identification des individus en mouvement. 
b. Utiliser la fonction Grid, comme repère pour diviser le quadrat. 
c. Estimer le nombre d’individus ( 
d. Figure 11). 
e. Ajouter un point sur le jeu de données (p. ex. Bivalvia banc) et inscrire le nombre 

d’individus estimés pour le déploiement, manuellement dans le fichier d’exportation des 
données brutes. 

7. Gérer les déploiements sans occurrence. 
a. En cas d’absence d’organisme, il faut annoter la photo afin de l’indiquer et ajouter un ROI 

multipoint avec une indication (ex. Aucune occurrence) afin d’obtenir un fichier de résultat 
.zip. 

b. Coller ensuite les données dans le chiffrier d’exportation des données brutes. 
 
Mesures linéaires 2D 
 
1. Effectuer une mesure linéaire sur une photo calibrée et annotée.  

a. Ouvrir Analyze > Tools > ROI Manager. 
b. Sélectionner un taxon qui a été préalablement annoté afin de l’afficher à l’écran. 
c. Cliquer sur l'outil Straight Line 
d. Tracer une ligne de mesure en cliquant et maintenant le bouton gauche de la souris pour 

mesurer un individu  
e. Cliquer sur Add. 
f. Renommer le ROI selon le nom du taxon suivi de son numéro dans le ROI multipoint. 

Attention, les mesures de longueur doivent être effectuées dans le même ordre que le 
ROI afin d’associer la mesure au bon individu.  

g. Répéter les étapes d-f en fonction du nombre d’individus dans le taxon. 
h. Répéter les étapes d-g pour chaque taxon sur la photo. 

2. Enregistrer le fichier ZIP et extraire les données au besoin. 
 
Mesures de surface 2D 
 
1. Créer des jeux de données de type polygones avec l’outil de sélection.  

a. Ouvrir Analyze > Tools > ROI Manager. 
b. Cliquer sur l'outil Polygon. 
c. Tracer le contour de l'intérieur du quadrat jusqu'à relier tous les points. 
d. Cliquer sur Add. 
e. Sélectionner le ROI nouvellement créé et cliquer sur Rename. 
f. Nommer le quadrat 50 x 50 cm et cliquer sur OK. 
g. Désélectionner le ROI 50 x 50 cm. 
h. Double-cliquer sur Show All afin de tout désélectionner.  
i. Ajouter un nouveau ROI. 
j. Cliquer sur l'outil Polygon ou Freehand. 
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k. Tracer le polygone autour des composantes biotiques voulues (ex. petit thalle d’algues 
rouges) en incluant toutes les parties visibles en vue verticale, mais uniquement celles à 
l'intérieur du quadrat (Note : un ROI peut contenir plusieurs polygones) (Figure A1.13). 

l. Terminer le polygone en reliant les points. 
m. Maintenir la touche Shift du clavier et cliquer un premier point dans un autre secteur pour 

créer un autre polygone. 
n. Relâcher la touche Shift et tracer un autre polygone en reliant les points. 
o. Répéter les opérations k-n tant qu'il y a des polygones à tracer. 
p. Cliquer sur Add. 
q. Cliquer sur le ROI nouvellement créé et cliquer sur Rename. 
r. Nommer le ROI selon le nom de la composante biotique et cliquer sur OK. 

 

 
Figure A1.13. Définition du contour de macroalgues rouges Rhodophyta à l’intérieur du quadrat 
avec l’outil de type « polygone » Freehand. 
 
2. Créer des jeux de données de type polygones avec la fonction de sélection par seuils de 

couleur Color Threshold. 
a. Ouvrir une photo corrigée pour la balance des blancs. 
b. Ouvrir ROI manager. 
c. Délimiter l’aire du quadrat, cliquer sur Add afin d’ajouter le ROI 50 x 50 cm et cliquer par 

la suite sur Edit > Clear outside de manière à uniquement conserver l’image intérieure du 
quadrat (Figure A1.14). 
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d. Sélectionner la fonction Image > Adjust > Color Threshold. 
e. Conserver les paramètres par défaut. 
f. Sélectionner la plage de l’espace colorimétrique de la tonalité (HUE) correspondant à 

l’espèce à l’étude. Par exemple, sélectionner la plage du jaune-vert jusqu’au vert bleu, 
entre 50 et 150o, pour sélectionner automatiquement la surface des feuillages de Zostera 
marina.  

g. Modifier la plage de la saturation et de la luminosité jusqu’à avoir la sélection souhaitée 
pour l’organisme (Note : La zone d’intérêt devient rouge) (Figure A1.15). 

h. Cliquer sur Select, puis cliquer sur Add et identifier l’annotation correspondant à l’espèce 
à l’étude (Note : la zone d’intérêt dont l’aire est mesurée apparaît alors avec des contours 
jaunes [ 

i. Figure 15]). Dans certains, la fonction Color threshold ne donne pas des résultats 
acceptables et il est alors possible d’utiliser des outils semi-quantitatifs (voir Short et Coles 
2001). 

Figure A1.14. Suppression des contours extérieurs du quadrat pour l’extraction de l’image à 
analyser. 
 

 
Figure A1.15. Outil de sélection d’une surface en fonction de seuils Color Threshold de ses 
propriétés de couleur des organismes.  
 
3. Enregistrer des mesures de surface. 

a. Enregistrer les ROIs, en maintenant la touche Shift et en sélectionnant tous les ROIs. 
b. Cliquer More > Save. 
c. Enregistrer le fichier avec tous les ROIs dans le dossier de la séquence du 

déploiement. 
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d. Nommer le fichier ZIP selon le OpCode et le suffixe area (ex. IML-2021-033_T11-
01_CPD-1_20210865_1201_Area.zip). 

4. Extraire des données issues des mesures de surface. 
a. Ajuster les paramètres d’enregistrement des mesures, en cliquant Analyze > Set 

Measurements (Figure A1.13). 
b. Cocher AREA et Display labels seulement. 
c. Cliquer sur Measure et un tableau de résultats apparaît. 
d. Cliquer sur File > Save as et enregistrer le tableau sous un .csv. Ouvrir le .csv dans 

Excel et transférer l’onglet dans le fichier d’exportation des données brutes (p. ex. IML-
2022-025_CPD_BIO.xlsx) (Figure A1.14). 
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ANNEXE 2: PROCÉDURES D’ANALYSES VIDÉO 
STÉRÉOSCOPIQUES AVEC EVENTMEASURE (EM) 

 
2.1 Organisation et nomenclature des fichiers 
 
1. Lors des missions en mer, sauvegarder les séquences vidéo brutes dans des dossiers de 

manière à classer les déploiements par date, par engin, et par caméra. Cette étape constitue 
un pré-triage seulement et peut être omise si l’horaire permet de faire directement le 
classement final décrit à l’étape 2. 

2. Effectuer une copie des vidéos brutes et renommer et classer les fichiers vidéo dans des 
dossiers. 

a. Créer la liste des identifiants uniques à partir des métadonnées de chaque 
déploiement CVSA (OpCode), comme dans l’exemple au Tableau 1. 

b. Pour chaque déploiement, prévisionner les vidéos afin de vérifier s’ils correspondent 
à l’OpCode sur le panneau d’affichage du déploiement (présenté avant la mise à 
l’eau). 

c. Utiliser la liste des identifiants uniques pour créer un nouveau dossier nommé selon 
l’OpCode, et un sous-dossier pour la caméra de gauche (ex. C2_G) et un autre pour 
la caméra de droite (ex. C1_D); il est important d’utiliser la fonction copier-coller pour 
renommer les dossiers afin d’éviter les erreurs. 

d. Une fois tous les dossiers créés, classer les vidéos du déploiement dans leur dossier 
respectif. 

e. Regrouper tous les dossiers par station et par mission. 
3. Renommer les séquences vidéo à l’aide d’un logiciel (ex. Bulk rename utility) à partir des 

dossiers renommés selon l’OpCode, le code de caméra, et y ajouter un numéro séquentiel 
en suffixe. 

4. Rassembler toutes les séquences vidéo renommées dans le dossier du déploiement (Figure 
A2.1). 

 

https://www.bulkrenameutility.co.uk/
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Figure A2.1. Exemple de la structure d’archivage et de nomenclature d’un déploiement CVSA 
(ex. dossier OpCode 025_045_1_20220702_RE1 dans le dossier terrain RE_045), incluant les 
séquences vidéo de la caméra #1 avec la vue côté droit ‘’C1_D’’ et de la caméra #2 avec la vue 
côté gauche ‘’C2_G’’. Les dossiers C1_D et C2_G sont utilisés pour l’archivage des séquences 
brutes non-renommées. 
 
2.2 Visionnement préliminaire et qualité des vidéos 
 
1. Ouvrir le dossier du déploiement CVSA (OpCode) et visionner toutes les séquences vidéo 

avec VLC (ou autre lecteur vidéo) en vitesse accélérée. 
2. Évaluer la qualité des vidéos pour chaque déploiement, en fonction des critères d’évaluation 

de la visibilité (en termes de clarté de l’eau) et du champ visuel (degré d’obstruction du champ 
de vision CDV) (Tableau 3). 

3. Déterminer la catégorie appropriée pour la Visibilité et le champ visuel en se référant à la  
4. Figure 4.  
5. Compléter le fichier de visionnement préliminaire pour chaque déploiement et y inscrire les 

valeurs de visibilité et de champ visuel pour chaque déploiement (OpCode) prévisionné tel 
que présenté dans l’exemple ci-dessous (Tableau A2.1). 

 
Tableau A2.1. Éléments d’information à compléter dans le fichier du visionnement préliminaire. 

OpCode Visibilité Vue Tape_Reader Commentaires 

050_BC37_1_20191006_F1 3 3 AR Caméra gauche inclinée 

 
6. Noter dans la colonne COMMENTAIRES toutes les informations concernant les problèmes 

liés au système CVSA (i.e., obstruction du champ de vision (CDV), problème d’éclairage 
artificiel, angle d’inclinaison et orientation des caméras). Note : Si le CVSA est complètement 
orienté vers le haut ou vers le bas, le déploiement CVSA est considéré comme nul. S’il n’y a 

https://www.videolan.org/vlc/
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qu’une seule caméra (Cam-G ou Cam-D), la séquence vidéo est tout de même analysée, 
mais aucune mesure stéréoscopique ne pourra être réalisée. 

 
2.3 Calibration des vidéos avec CAL 
 
1. À noter que les calibrations des caméras sont réalisées en bassin et que les fichiers de 

calibration sont produits avec le logiciel CAL, selon la procédure recommandée par SeaGIS; 
la calibration des vidéos est réalisée en fonction du modèle et des paramètres 
d’enregistrement des caméras (ex. GoPro Hero 5 Black 1920x1080 medium FOV 21 mm ou 
équivalent). 

2. Utiliser uniquement les fichiers de calibration qui vous sont fournis, pour chaque mission. 
Chaque engin à sa propre calibration (avant et après chaque mission). 

 
2.4 Création d’un fichier modèle avec EventMeasure 
 
Afin d’assurer l’uniformité des bases de données qui seront extraites avec EventMeasure, il est 
recommandé de créer un fichier modèle à utiliser pour toutes les analyses vidéo. Tous les 
éléments qui seront inscrits dans les champs d’information et les attributs apparaîtront dans les 
tables de données générées par EventMeasure au moment de leur production.  
 
Configuration des champs d’information 
 
Le logiciel EventMeasure permet d’inscrire certaines informations propres aux déploiements. Il y 
a douze champs d’informations, dont quatre sont prédéterminés par le logiciel («OpCode», 
«TapeReader», «Depth» et «Comment»).  
 
1. Ouvrir EventMeasure. 
2. Cliquer sur Measurement > Information fields > Edit field names. 
3. Cliquer dans la case appropriée de la colonne Name et entrer le nom des champs 

d’information désirés pour les champs cinq à douze, tel que présenté à la Figure A2.2. 
4. Cliquer sur Close dialog afin d’enregistrer les champs d’information automatiquement en se 

référant au Tableau A2.2 pour la description des champs utilisés. 
 

 
Figure A2.2. Configuration du fichier EventMeasure – Champs d’informations. 

https://www.seagis.com.au/bundle.html
https://www.seagis.com.au/download.php
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Tableau A2.2. Description des champs d’information figurant dans le fichier EventMeasure. 

Champ d'info  Description 

OpCode Code du déploiement CVSA composé du numéro de mission, du code de 
station, de la position d'échantillonnage, de la date et du code de l'activité. 

TapeReader Initiales de la personne qui réalise les analyses vidéo. 

Depth Profondeur (m) de la colonne d'eau (entre surface et fond) au début du 
déploiement CVSA. Profondeur corrigée en fonction de la profondeur de 
lecture sur l'échosondeur du navire et la position du capteur sous la 
surface de l'eau. 

Comment Tous commentaires pertinents concernant les 
paramètres d’échantillonnage (p. ex., lumières éteintes, enregistrement 
incomplet) 

Date Date du début du déploiement (aaaa-mm-jj). 

ImageSyncho Numéro de l'image de gauche synchronisée avec le numéro de l'image de 
droite (ex. 230_238). 

CalCode Code du dossier contenant les fichiers de calibration utilisés. 

Sub_Principal Composante du substrat la plus abondante, observée sur les vidéos de 
gauche et de droite (adapté de FGDC 2012). 

Sub_Secondair
e 

Deuxième composante du substrat la plus abondante, observée sur les 
vidéos de gauche et de droite (adapté de FGDC 2012). 

Lum_initiale Présence/absence de lumière de surface et fonctionnement des 
lampes (p. ex., pas de lumière naturelle, lampes fonctionnent normalement 
= b1). 

PCDV_initiale Évaluation de la profondeur du champ de vision (PCDV) initiale, à partir de 
la mesure (Point 3D) d'un repère visible sur le fond (lorsque possible). 

Courant_initial Direction et intensité initiales du courant par rapport à la cage d’appât sur 
le vidéo de gauche (ex. courant de face, intensité forte = a3). 

 
Configuration des attributs 
 
Les tables de données (points et mesures) du fichier EventMeasure contiennent différentes 
colonnes avec différents noms de variables, que l’on nomme ici les attributs. Un maximum de 10 
attributs peut être utilisé, dont 8 sont prédéterminés par le logiciel («Familly», «Genus», 
«Species», «Code», «Number», «Stage», «Activity» et «Comment»).  
 
1. Configurer le nom des attributs en cliquant sur Measurement > Attributes > Attribute headers 

en se référant au Tableau A2.2 pour lire la description des attributs utilisés.  
2. Sélectionner l’une des cases 8 à 10, pour en modifier le nom comme à la Figure A2.3. 
3. Cliquer sur Close dialog pour enregistrer automatiquement. 
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Figure A2.3. Configuration des noms d’attributs. 
 
Importation de la liste de taxons, morphotypes, et OTU, et des listes d’attributs 
 
La liste d’espèces personnalisée et celles des différents attributs doivent être importées dans le 
fichier modèle EventMeasure, afin d’avoir accès au menu déroulant lors des annotations de points 
et de mesures.  
 
1. Importer les listes dans EventMeasure, en cliquant sur Measurement > Attributes > Edit/load 

species files, tel que présenté à la Figure A2.4. 
2. Charger chaque liste en format texte, en cliquant dans la case appropriée de la colonne 

Current file : 
a. Liste d’espèces : sélectionner le fichier EM_Taxons_IML_aaaammjj.txt; 
b. Liste de l’attribut 1 : Comment : sélectionner le fichier Comment.txt; 
c. Liste de l’attribut 2 : SpeciesInOut : sélectionner le fichier SpeciesInOut.txt; 
d. Liste de l’attribut 3 : MesureID : sélectionner le fichier MesureID.txt. 

3. Cliquer sur Close dialog. 
 

 
Figure A2.4. Importation de la liste d’espèces et des listes d’attributs dans EventMeasure. 
 
Activation des règles de mesures stéréoscopiques 
 
EventMeasure offre la possibilité de définir certaines règles à respecter lors des mesures 
stéréoscopiques. En activant les règles, le logiciel affiche un avertissement lorsque les valeurs 
définies sont outrepassées, et ce, lors des mesures de longueur ou de points 3D. Il vous sera 
alors possible de reprendre vos mesures le cas échéant.  
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1. Configurer les règles de mesures stéréoscopiques en cliquant sur l’onglet Stereo > Length/3D 

rules. 
 

 
Figure A2.5. Activation des règles de mesures stéréoscopiques. 
 
2. Activer les règles en inscrivant True dans la colonne Data et inscrire les valeurs 

recommandées pour la distance, le RMS et le ratio précision longueur (Langlois et al. 2020) 
ainsi que pour la direction horizontale, tel que présenté à la Figure A2.5. 

a. Use length rules : Activer la fonction d’avertissement pour l’utilisation des règles de 
mesures. 

b. Apply range rule : Activer la règle sur la distance à respecter lors des mesures et de 
s’assurer d’avoir la distance minimale à 0 mm et la distance maximale à 8000 mm. 
Au-delà de 8000 mm, EventMeasure lancera un avertissement et vous devrez rejeter 
la mesure et en reprendre une nouvelle.  

c. Apply RMS rule : Activer la règle RMS et s’assurer que la valeur maximale définie soit 
de 20 mm. Au-delà de 20 mm, EventMeasure lancera un avertissement et vous devrez 
rejeter la mesure et en reprendre une nouvelle. 

d. Apply precision to length ratio rule : Activer la règle pour le ratio de précision longueur 
et s’assurer que la valeur maximale définie soit de 10 %. Au-delà de 10 %, 
EventMeasure lancera un avertissement et vous devrez rejeter la mesure et en 
reprendre une nouvelle. 

e. Apply horizontal direction rule : Activer la règle de mesure pour la direction horizontale 
et s’assurer que la valeur maximale définie soit de 45.0000. 

f. S’assurer de ne pas activer les valeurs pour l’angle vertical ni pour les coordonnées x 
et y; laisser les valeurs par défaut. 

g. Cliquer sur Close dialog. 
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Enregistrement du fichier modèle EventMeasure 
 
1. Enregistrer le fichier (.Emobs) en cliquant sur Measurement > Save. 
2. Enregistrer le fichier modèle sous le nom de Modèle_AnalysesEM.emobs et le conserver dans 

vos dossiers. 
3. Utiliser le même fichier pour toutes les analyses, et ce pour chaque déploiement tel que 

présenté dans la section Démarrage des analyses avec EventMeasure. 
 
2.5 Démarrage des analyses avec EventMeasure 
 
Une fois le déploiement choisi, il faut procéder à l’importation et à la synchronisation des vidéos 
de la caméra de gauche et de droite dans l’interface principale d’EventMeasure. Les 
métadonnées de terrain sont saisies dans la section champs d’information, tout comme les 
données de synchronisation des vidéos et de calibration. L’identification du début et de la fin de 
l’immersion va permettre d’arrimer les données avec celles de la sonde et du courantomètre 
intégrés au CVSA, alors que l’identification de la période d’analyse va servir à calculer la durée 
de l’analyse. À la fin, le fichier du déploiement est enregistré et porte le code du déploiement 
(OpCode) comme nom. Toutes les étapes concernant le démarrage des analyses sur 
EventMeasure sont présentées ci-dessous. 
 
Ouverture du fichier d’analyse EventMeasure 
 
1. Copier le fichier .emobs « Modèle_Analyses EM» dans le dossier du déploiement, contenant 

toutes les séquences vidéo de la caméra de droite et de la caméra de gauche et renommer 
le fichier selon l’OpCode du déploiement. 

2. Ouvrir le fichier .emobs du déploiement afin d’ouvrir EventMeasure. 
 
Importation des vidéos 
 
1. Définir le répertoire des vidéos en cliquant sur Picture > Set picture directory. 
2. S’assurer que les séquences vidéo de type MP4 Video File (VLC) des 2 caméras (gauche et 

droite) sont dans le même dossier de déploiement et classées selon l’ordre séquentiel 
croissant. 

3. Charger la première séquence vidéo de la caméra gauche ([…]G_01.MP4) en cliquant sur 
Picture > Load picture; sélectionner la vidéo et cliquer sur Ouvrir (Figure A2.6) 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure A2.6. Importation de la séquence pré-mouillage de la caméra gauche. 
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4. Charger les autres séquences vidéo en cliquant sur Picture > Define movie sequence > Add 
file(s). Sélectionner les vidéos et choisir le format de temps (en hh :mm :ss) (Figure A2.7).  

5. Cliquer sur Ouvrir, puis OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure A2.7. Importation de la suite de la séquence de la caméra gauche. 
 
6. Charger la première séquence vidéo de la caméra droite ([…]D_01.MP4) en cliquant sur 

Stereo > Picture > Load picture. Sélectionner la vidéo et cliquer sur Ouvrir. 
7. Charger les autres séquences vidéo en cliquant sur Stereo > Picture > Define movie sequence 

> Add file(s). Sélectionner les vidéos, cliquer sur Ouvrir et puis OK. 
 
Synchronisation des vidéos 
 
La synchronisation des vidéos de la caméra de gauche et de droite s’effectue sur l’interface 
principale en débutant individuellement la lecture des caméras à la recherche du point de signal 
donné visible par les deux caméras, telle que présentée sur la Figure A2.8. Une bonne 
synchronisation diminue les risques d’erreurs lors des prises de mesures 3D (Harvey et al. 2002). 
 

 
Figure A2.8. Synchronisation des caméras en repérant le point de signal. 
 
1. Dans la section réservée à la caméra gauche, cliquer sur Play movie : 

a. Cliquer sur Oui ou Non pour désactiver le son dans la fenêtre contextuelle qui apparaît. 
b. Repérer le moment où le signal est donné (i.e., dernier frame des doigts qui se 

touchent, juste avant qu’ils ne commencent à s’éloigner l’un de l’autre) et appuyer sur 
Close player and update position. 

2. Répéter les étapes précédentes pour la caméra droite en repérant le même point de signal. 
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3. Cliquer dans le carré Lock. 
4. Noter le numéro de l’image de la séquence vidéo (#Frame) de la caméra gauche et de la 

caméra droite (ex. 350_350), puisque ces valeurs sont consignées dans la section du champ 
d’information «ImageSynchro» (voir section Saisie des valeurs des champs d’information de 
la procédure 2.5). 

 
Saisie des valeurs des champs d’information 
 
Certaines informations du champ Informations field sont disponibles et doivent être entrées à ce 
moment. Il est possible de se référer au Tableau 2 pour la description des variables à inscrire. 
 
1. Cliquer sur l’onglet Measurement > Informations field > Edit field values, et saisir les 

informations concernant le déploiement tel que présenté dans l’exemple de la Figure A2.9. 
2. Cliquer sur Close dialog afin d’enregistrer les champs d’information automatiquement. 
3. À noter qu’aucun accent ou caractère spécial ne doivent être entrés dans ces champs. De 

plus, la profondeur doit contenir un point et non une virgule.  
 

 
Figure A2.9. Configuration du fichier EventMeasure – Champ d’informations. 
 
4. Remplir les 5 autres champs «Sub_principal», «Sub_Secondaire», «Lum_initiale», 

«PCDV_initiale» et «Courant_initial», une fois les analyses du substrat et des conditions 
environnementales complétées (voir section Évaluation et suivi des conditions environnantes 
de la procédure 2.6). 

 
Importation des fichiers de calibration 
 
1. Importer les fichiers de calibration appropriés pour la caméra gauche et droite, tel que 

présenté à la Figure A2.10. 
2. Charger les fichiers de calibration (.CAM) sélectionnés, en cliquant sur : 

a. Stereo > Cameras > Left > Load camera file> LEFT_ Cal[…]_G; 
b. Stereo > Cameras > Right > Load camera file > RIGTH_ Cal[…]_D. 

3. Enregistrer le fichier en cliquant sur Measurement > Save > Enregistrer.  
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Figure A2.10. Chargement des fichiers de calibration (.CAM). 
 
Détermination du point de début de l’immersion 
 
1. Visionner la vidéo de gauche et avancer la séquence jusqu’au moment où le CVSA touche 

l’eau, au tout début de la descente. 
2. Cliquer (clic droit) sur la barre de la cage à appât et sur Add point. 
3. Dans le menu déroulant de l’attribut Comment, sélectionner « Immersion – Debut ». 
4. Supprimer toutes les autres valeurs des attributs avant de cliquer sur OK, comme le montre 

la Figure A2.11 (Note : ce moment correspond à l’heure de début du déploiement inscrite 
dans les métadonnées).  

 

 
Figure A2.11. Détermination du point de début de l’immersion. 

 
Détermination du point du début de l’analyse 
  
1. Avancer la séquence vidéo du début d’immersion du CVSA jusqu’à ce que le cadre touche le 

fond et que la visibilité se stabilise.  
2. Cliquer (clic droit) sur la barre de la cage à appât et sur Add point, puis dans le menu déroulant 

de l’attribut Comment, sélectionner « Analyses – Debut ». 
3. Supprimer toutes les autres valeurs des attributs avant de cliquer sur OK. 
 
Activation du début de la période d’analyse 
 
1. Activer le début de la période d’analyse (Temps 0), en cliquant (clic droit) sur le bras d’appât, 

puis sur Period definitions > Add new period start tel que présenté à la Figure A2.12. 
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Figure A2.12. Activation du début de la période d’analyse.  
 
2. Nommer la période avec le nom de la station et le numéro du système CVSA (ex. BC37_1). 
3. Vérifier si la colonne Period Time (mins) indique 00 :00 :00.00 au niveau du point de « Analyse 

– Debut ». 
 
Détermination du point de la fin des analyses  
 
1. Repérer le moment où l’analyse prend fin, juste avant la remontée du CVSA à la surface ou 

lorsque l’enregistrement est terminé. 
2. Cliquer (clic droit) sur la barre de la cage à appât et sur Add point, puis dans le menu déroulant 

de l’attribut Comment, sélectionner « Analyses – Fin ». 
3. Supprimer toutes les autres valeurs des attributs avant de cliquer sur OK. 
 
Activation de la fin de la période d’analyse 
 
1. Activer la fin de la période d’analyse en cliquant (clic droit) sur Period definitions; puis sur Set 

period end et sur OK. 
2. Noter que toutes les annotations réalisées après cette période n’auront pas de valeur 

associée pour Period Time (HMS). 
 
Détermination du point de la fin de l’immersion 
 
1. Repérer le dernier moment où le CVSA est immergé dans l’eau, avant sa remontée à bord de 

l’embarcation. 
2. Cliquer (clic droit) sur la barre de la cage à appât et sur Add points. 
3. Dans le menu déroulant de l’attribut Comment, sélectionner « Immersion – Fin ». 
4. Supprimer toutes les autres valeurs des attributs avant de cliquer sur OK. 
5. Noter que le point de fin d’immersion correspond à l’heure de fin du déploiement dans les 

métadonnées. 
 
Enregistrement du fichier d’analyse EventMeasure 
 
1. Créer un point 3D avant l’enregistrement du fichier, pour permettre l’importation des 

séquences vidéo en un seul clic lors de la réouverture. Cette étape est recommandée, car si 
vous deviez fermer votre fichier .emobs avant d’avoir eu le temps de compléter l’analyse du 
substrat et des conditions initiales, ce point temporaire peut être utilisé pour récupérer le 
fichier : 
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a. Cliquer (clic gauche) dans l’image de gauche. Une croix apparaît dans l’image et une 
ligne épipolaire apparaît dans l’image de droite. 

b. Suivre la ligne épipolaire afin de repérer la position correspondant au même point dans 
l’image de droite. 

c. Cliquer (clic gauche) sur le même point dans l’image de droite. Une autre croix 
apparaît dans l’image de droite. 

d. Cliquer (clic droit) sur l’une des croix puis sur Add 3D point. Une boîte de dialogue 
s’ouvrira et affichera les informations du point 3D. 

e. Noter en commentaire « Point 3D » puis cliquer sur OK. 
2. Sur la barre de travail EventMeasure, cliquer sur Measurement > Save. 
3. Enregistrer le fichier dans le dossier du déploiement sous le nom de l’OpCode (ex. 

025_045_1_20220702_RE1). 
 
Visionnement en stéréoscopie 
 
EventMeasure ne permet pas de lire et d’annoter les séquences vidéo de gauche et de droite en 
même temps. Il est donc nécessaire de créer une copie indépendante du fichier .Emobs pour le 
visionnement stéréoscopique. Le visionnement s’effectue en temps réel et en accéléré afin de 
détecter un maximum d’organismes dans le champ d’analyse. 
 
1. Créer un dossier appelé STEREO. 
2. Déposer une copie du fichier .Emobs du déploiement en cours d’analyse dans ce dossier, tel 

qu’enregistré précédemment. 
3. Ouvrir les deux fichiers .Emobs du déploiement simultanément. 
4. Utiliser le point 3D enregistré, pour synchroniser les vidéos automatiquement sur les fichiers 

nouvellement ouverts. 
a. S’assurer que la case Lock est activée. 
b. Dans Data view; sélectionner 3D Measurements, puis double cliquer sur la ligne du 

point 3D enregistré afin de voir apparaître les images de la caméra gauche et de la 
caméra de droite automatiquement. 

5. Tester le visionnement des caméras de gauche et de droite en simultané. 
a. Sur le fichier du déploiement analysé et annoté, cliquer sur Play movie, au niveau de 

la caméra gauche; puis cliquer Oui ou Non à la question concernant le son. 
b. Sur le fichier du déploiement issu du dossier STEREO, cliquer sur Play movie, au 

niveau de la caméra droite; puis cliquer Oui ou Non à la question concernant le son. 
c. S’assurer que les fenêtres de visionnement sont de tailles égales et collées l’une à 

l’autre, dans le plus grand écran disponible. Ajuster le poste de travail en se référant 
à la Figure A2.13 pour avoir un aperçu du mode de visionnement.  

  
Figure A2.13. Lecture des séquences vidéo de la caméra gauche et de la caméra droite en 
simultané, avec le logiciel EventMeasure. 
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6. Utiliser les accès rapides pour démarrer les vidéos en simultané ou naviguer d’un vidéo à 
l’autre (en temps réel et en accéléré). Consulter SeaGIS (2019) pour une description des 
accès rapides. 

7. Fermer les fenêtres de visionnement. Elles se réouvriront selon la configuration actuelle 
lorsque le moment de l’analyse des séquences vidéo débutera. 

 
2.6 Analyse du substrat et des conditions environnementales avec EventMeasure 
 
Une évaluation qualitative du substrat et des conditions environnementales initiales sur le site 
d’échantillonnage est effectuée en début d’analyse pour chaque déploiement. Il est nécessaire 
de compléter la saisie de ces données dans le champ d’information d’EventMeasure. Un suivi de 
tout changement en cours d’analyse est également effectué, à l’aide des points d’annotations.  
 
Conditions initiales 
 
1. Naviguer à l’image de départ en double cliquant sur le point « Analyse – Debut » (Temps 0). 
2. Remplir la section « Champs d’information » (voir Saisie des valeurs des champs 

d’information section Annexe 2.5). 
3. Identifier le type de substrat principal et secondaire visible dans le champ d’analyse. 

a. Utiliser les outils de mesures 3D pour estimer la taille des particules du substrat. 
b. Remplir les champs « Sub_principal » et « Sub_secondaire » en se référant au 

Tableau 6 du rapport pour la description des « Champs d’information » et à la Erreur ! 
Source du renvoi introuvable. pour des exemples visuels des différents substrats. 

4. Évaluer la profondeur du champ de vision initiale (PCDV) en utilisant le point 3D : : 
a. Repérer un endroit, représentant la limite maximale visible, en termes de profondeur 

(distance) dans le champ d’analyse stéréoscopique, au niveau de l’interface entre la 
colonne d’eau et le substrat. 

b. Ajouter le point 3D (clic gauche sur les deux images, clic droit sur une des croix, Add 
3D point) en s’assurant que les informations affichées respectent les règles 
stéréoscopiques définies. 

c. Noter la distance calculée du champ Range de la boîte de dialogue 3D information, 
afin de catégoriser la PCDV initiale. 

d. Cliquer (clic droit) sur l’une des croix effectuées, puis sur Add 3D point et sélectionner 
la valeur appropriée dans le menu déroulant de l’attribut Comment. 

e. Entrer Environnement dans l’attribut Family. Supprimer toutes les autres valeurs des 
attributs, tel que présenté à la Figure A2.14 et cliquer OK. 

f. S’assurer que le point 3D apparaît dans la section 3D Measurements du Data view 
d’EventMeasure. 

g. Noter la valeur dans le champ d’information « PCDV_initiale ». 
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Figure A2.14. Création d’un point 3D, lors de la mesure de la profondeur du champ de vision 
(PCDV) au début de l’analyse sur EventMeasure. PCDV estimée à 2430 mm dans l’exemple. 
 
5. Évaluer la luminosité initiale en déterminant s’il y a présence de lumière naturelle et si 

l’éclairage artificiel fonctionne normalement. Noter la valeur dans le champ d’information 
« Lum_initiale ». 

6. Évaluer le courant initial en déterminant la direction et l’intensité du courant initial par rapport 
à la cage d’appât, en effectuant la lecture vidéo de la caméra gauche, pendant quelques 
secondes. Noter la valeur dans le champ d’information « Courant_initial ». 

7. Compléter les champs d’informations manquants en cliquant sur l’onglet Measurement > 
Informations fields > Edit field values. 

8. Inscrire les valeurs pour les champs d’information 8 à 12 tels que présenté à la Figure A2.15 
et cliquer sur Close dialog, afin d’enregistrer les champs d’information. 

9. Cliquer sur Measurement puis sur Save... pour sauvegarder le fichier .Emobs. 
 

 
Figure A2.15. Valeurs pour les différents champs d’informations initiales pour un déploiement 
CVSA. 
 
Changement de conditions en cours d’analyse 
 
1. Ajouter un point d’annotation 2D avec un commentaire dès qu’un changement susceptible 

d’affecter l’échantillonnage vidéo se produit dans le milieu ambiant en cliquant sur le vidéo de 
gauche et sur Add point. 
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2. Sélectionner l’élément « Environnement » dans le menu déroulant Family et noter le 
changement dans la section Comment, tel que dans l’exemple à la Figure A2.16. 

 

 
Figure A2.16. Annotation d’un point à la suite d’un changement dans les conditions 
environnementales. Exemple d’une obstruction partielle des caméras par Amphipoda, en cours 
d’analyse. 
 
3. Noter tous changements notoires dans les conditions environnementales tout au long du 

déploiement en se référant au tableau 5 pour des exemples. 
4. Reprendre une mesure PCDV (avec un point 3D) lorsque des changements en turbidité ou 

en lumière sont observés. 
5. Repérer les périodes d’apparition et disparition de bruits susceptibles d’affecter 

l’échantillonnage, lors du visionnement des vidéos en temps réel avec son ou avec l’utilisation 
d’outils permettant d’obtenir un visuel sonore afin d’éviter de devoir écouter l’audio des vidéos 
durant les analyses. 

a. Utiliser la fonction de visualisation audio de VLC lors du visionnement préliminaire, en 
cliquant sur Audio > Visualisations > Oscilloscope ou tout autre logiciel d’édition vidéo 
permettant la visualisation de l’onde sonore, tel que Open Shot (Logiciel ouvert et 
gratuit). 

 
2.7 Analyse de la biodiversité avec EventMeasure 
 
Dénombrement 
 
Annotations, décomptes et points 2D 
 
1. Annoter les organismes visibles sur la caméra gauche. 

a. Cliquer (clic droit) directement sur l’organisme et sélectionner Add point. 
b. Remplir les champs Family, Genus et Species, selon l’identification de l’organisme. 
c. Laisser la valeur de 1 (par défaut) pour l’attribut Number pour les annotations 

individuelles (Figure A2.17). 
d. Laisser les autres valeurs par défaut, incluant « AD » pour le stade Stage et 

« Passing » pour l’activité Activity, et cliquer sur OK. 
 

https://www.openshot.org/fr/
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Figure A2.17. Annotation 2D individuelle d’une morue Gadus morhua sur la caméra gauche. 
 
2. Annoter les organismes visibles uniquement sur la caméra de droite. 

a. Cliquer (clic droit) sur la barre d’appât et sélectionner Add point. 
b. Remplir les champs Family, Genus et Species, selon l’identification de l’organisme 

(Note : ne pas inscrire de caractères spéciaux, tels que les virgules ou les accents). 
c. Préciser le nombre d’individus visibles uniquement sur la caméra de droite dans le 

champ Number. 
d. Choisir « Cam-D » dans le menu déroulant du champ Comment. 
e. Laisser les valeurs des autres champs tels qu’ils apparaissent à la Figure A2.17 et 

cliquer sur OK. 
3. Utiliser l’attribut Comment pour indiquer *** lorsque le ou les organismes annotés nécessitent 

une identification ou une validation taxonomique. L’usage du commentaire et symbole *** 
permettra aux experts taxonomistes de retrouver facilement le moment de la séquence vidéo 
nécessitant une validation d’identification. 

4. Se référer à la Erreur ! Source du renvoi introuvable. pour des exemples de décompte 
incluant des individus uniquement visibles sur la caméra de droite. 

 
Suivi des entrées et sorties (exemple pour des spécimens de poissons) 
 
1. Balayer les séquences vidéo (gauche et droite) et visionner les vidéos en temps réel, pour 

trouver les entrées « In » et les sorties « Out » pour toutes les espèces/taxons de poissons. 
2. Identifier et annoter chaque entrée « In » et chaque sortie « Out » (passage) (Figure A2.18). 

a. Créer un point 2D en indiquant le taxon et le nombre d’individus. 
b. Sélectionner « In » lorsque le premier individu d’une espèce de poisson entre dans le 

champ d’analyse dans le champ SpeciesInOut. 
3. Sélectionner « Out », lorsque le dernier individu d’une espèce de poisson sort du champ 

d’analyse et qu’aucun autre ne réapparaît dans un délai de 10 secondes.  
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Figure A2.18. Exemple d’un point d’annotation pour marquer l’entrée « In » de Mallotus villosus 
dans le champ d’analyse.  
 
Décompte initial 
 
1. Aller sur l’image de départ, au point « Analyses – Debut ». 
2. Identifier et annoter tous les organismes présents dans le champ d’analyse stéréoscopique 

des caméras gauche et droite, au temps 00 :00 :00. 
3. Identifier et annoter les organismes sessiles et/ou coloniaux, tels que les hydrozoaires, les 

bryozoaires, les éponges et certains tuniciers, d’un seul point pour mentionner leur présence. 
Laisser la valeur de 1 par défaut. 

4. Si une espèce (ou taxon) de poisson est déjà présente lors du décompte initial, ajouter « In », 
dans le champ SpeciesInOut. 

 
Décompte en cours de déploiement   
 
1. Effectuer les décomptes jusqu’à l’atteinte du nombre maximal d’individus, calculé pour une 

seule image par période d’analyse (MaxN) pour les invertébrés et les poissons en se référant 
à la  
Figure A2.19. 

a. Annoter le ou les individus de chaque espèce (ou taxon) dès leur première apparition 
et annoter à nouveau tous les individus dès que le nombre d’individus augmente. 

b. Suivre les décomptes dans le temps et ne plus annoter les individus si le nombre 
diminue ou est stable. 

c. Répéter ces étapes pour chaque taxon faisant une apparition « In » dans le champ 
d’analyse. 

 

 
Figure A2.19. Exemple de décomptes réalisés sur un banc de Mallotus villosus (avec estimation 
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du nombre d’individus), avec la période d’entrée « In » et de sortie « Out » figurant sur la table de 
points de Data EventMeasure. 
2. Effectuer le suivi des décomptes dans la table Cumulative MaxN pour visualiser les données 

selon le temps en se référant à la fenêtre Data MaxN (Figure A2.20). 
 

 
Figure A2.20. Visualisation des données du MaxN, automatiquement calculées par le logiciel 
EventMeasure, dans la table Data MaxN.  
 
Estimation du nombre d’individus à l'intérieur d’un banc ou d'une agrégation 
 
1. Traiter les agrégations de spécimens (p. ex. bancs de poissons ou d’invertébrés), comme une 

entité, lorsque les individus sont trop nombreux et pourraient différer lors de 3 décomptes 
indépendants. 

2. Mettre un point sur le banc, au centre de préférence ou sur la barre d’appât. 
3. Dénombrer par décompte manuel, ce qui est visible sur les deux écrans en même temps ou 

en entier sur l’un des écrans fixes. 
4. Dénombrer les individus visibles sur les deux écrans en même temps ou en entier sur l’un 

des écrans fixes. 
5. Bouger, au besoin, légèrement la séquence du banc ou utiliser un point 3D dans le paysage, 

comme repère, pour s’assurer de ne pas compter deux fois le même individu. Répéter ce 
décompte à trois reprises et effectuer la moyenne. 

6. Inscrire la moyenne obtenue/estimée dans le champ Number et y ajouter un (+). 
7. Inscrire dans le champ Comment « Banc », lorsque le nombre de spécimens est suffisamment 

élevé pour différer légèrement lors des 3 décomptes indépendants, en se référant à la  
8. Figure 13 pour des exemples de décompte en banc chez différents groupes taxonomiques. 
 
Prise de mesures 3D 
 
Pour la prise des mesures de taille des individus de différentes espèces/taxons ainsi que pour le 
suivi des conditions environnantes (ex. PCDV), l’annotation s’effectue sous forme de points 3D. 
Tous les organismes/objets présents dans le champ d’analyse stéréoscopique sont mesurés. 
 
Création de points 3D pour l’annotation 
 
1. Cliquer (clic gauche) d’abord sur un point précis visible sur la caméra gauche. Une croix 

apparaît dans l’image gauche et une ligne épipolaire apparaît dans l’image de droite. 
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2. Suivre la ligne épipolaire afin de repérer la position correspondant au même point sur 
l’organisme dans l’image de droite. 

3. Cliquer (clic gauche) ensuite sur ce même repère, au niveau de la caméra droite. Une autre 
croix apparaît. Une boîte de dialogue s’ouvrira et affichera les informations du point 3D. 

4. Cliquer (clic droit) sur l’une des croix puis sur Add 3D point. Une boîte de dialogue s’ouvrira 
et affichera les informations du point 3D. 

5. S’assurer que les informations respectent les règles stéréoscopiques établies. 
6. Sélectionner la valeur appropriée dans le menu déroulant de l’attribut Comment ou noter en 

commentaire la raison du point 3D (ex. PCDV, repère 3D) et puis cliquer sur OK. 
 
Mesures de taille 
 
Déterminer le type de mesure de taille à effectuer chez les poissons (Tableau A2.3, Figure A2.21) 
et pour les invertébrés (Tableau A2.4, Figure A2.22). 
 
Tableau A2.3. Différents types de mesure à préconiser chez les poissons, en fonction du type de 
nageoire caudale. 

Type de mesure Description 

Longueur à la fourche (FL = 
Fork length) 

Les mesures FL sont prises de l’extrémité antérieure du museau 
ou de la mâchoire à l’extrémité postérieure de la nageoire 
caudale (au rebord concave ou convexe) le long de l’axe 
longitudinal. Ce type de mesure convient pour la plupart des 
espèces ayant une forme de nageoire caudale arrondie, 
tronquée, émarginée, lunée ou en croissant, fourchu, 
rhomboïdale, en forme de S, pointue ou hétérocerque par 
exemple.  

Longueur totale (TL = Total 
length) 

Les mesures TL sont prises de l’extrémité antérieure du museau 
ou de la mâchoire à l’extrémité postérieure de la nageoire 
caudale (au rebord convexe seulement) le long de l’axe 
longitudinal. Ce type de mesure convient pour les espèces ayant 
un type de nageoire caudale homocerque, protocerque ou 
diphycerque (de forme arrondie, rhomboïdale, pointue) par 
exemple. À utiliser lorsqu'il est impossible de mesurer 
adéquatement une espèce à la fourche. 

Longueur standard (SL = 
Standard length) 

Les mesures SL sont prises de l’extrémité antérieure du museau 
ou de la mâchoire à l’extrémité postérieure du pédoncule caudal, 
le long de l’axe longitudinal. Ce type de mesure est utilisé lorsqu'il 
est impossible d'effectuer des mesures FL ou TL. 

  



88 
 

 

          

                

     
Figure A2.21. Illustrations de différentes mesures morphométriques utilisées chez différents 
groupes de poissons : A) exemple de mesures pour un poisson (ex. maquereau) incluant la 
longueur à la fourche (FL = Fork lenght) et longueur standard (SL = Standard lenght) (Figure 
adaptée de Hansen et al. 2018), B) exemple de mesures pour un requin, incluant la longueur 
totale (TL = total length) et la longueur pré-anale (PAL) préconisée pour la mesure des spécimens 
de grenadiers (Macrouridae) (Adaptée de Florida Museum 2023) et C) exemple de mesures pour 
une raie, incluant la longueur (TL = total length) et largeur du disque (DW) (Adaptée de Geniz et 
al. 2007).  
  

A 

B 

C 

https://www.floridamuseum.ufl.edu/discover-fish/sharks/anatomy/
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Tableau A2.4. Différents types de mesure à préconiser chez les invertébrés. 

Type de mesure Description 

Longueur totale                       
(TL = Total length) 

Les mesures TL sont prises de l’extrémité antérieure à l’extrémité 
postérieure, le long de l’axe longitudinal (p. ex. concombres de mer).  

Diamètre du test                     
(TD = Test diameter) 

Les mesures TD sont prises selon le diamètre du test, sans les 
épines (vue dorsale). Ce type de mesure convient pour les oursins 
par exemple. 

Longueur (post-orbitale) 
de la carapace                          
(CL = Carapace length) 

Les mesures CL sont prises de l'extrémité sous la base de l'œil (post-
orbitale) à l'extrémité postérieure du céphalothorax/carapace. Ce 
type de mesure convient pour les homards et les crevettes par 
exemple. 

Largeur de la carapace           
(CW = Carapace width) 

Les mesures CW sont prises sur la largeur, d'une extrémité à l'autre, 
incluant les épines (vue dorsale). Ce type de mesure convient pour 
les crabes par exemple. 

Longueur du manteau                
(ML = Mantle length) 

Les mesures ML sont prises de l'extrémité antérieure à l'extrémité 
postérieure du manteau. Ce type de mesure convient pour les 
calmars par exemple. 

Longueur de la coquille           
(SL = Shell length) 

Les mesures SL sont prises de l'extrémité antérieure de l'apex à 
l'extrémité postérieure de la base de la coquille. Ce type de mesure 
convient pour les gastéropodes par exemple. 

Hauteur de la coquille                
(SH = Shell heigth) 

Les mesures SH sont prises sur la hauteur, aux extrémités de la 
coquille. Ce type de mesure convient pour les pétoncles par 
exemple. 

Largueur de la coquille            
(SW = Shell width) 

Les mesures SW sont prises sur la largeur, aux extrémités de la 
coquille. Ce type de mesure convient pour plusieurs bivalves (ex. 
mactres, myes). 
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Figure A2.22. Illustrations de différentes mesures morphométriques utilisées chez différents 
groupes d’invertébrés dont A) le crabe, incluant le largueur de la carapace (CW = Carapace width) 
(Figure Adaptée de Haputhantri et al. 2021), B) le homard, incluant la longueur post-orbitale de 
la carapace (CL = Carapace length) (Adaptée de Rycroft et al. 2013), C) les bivalves, incluant la 
hauteur (SH = Shell Height) et la largeur de la coquille (SW = Shell width) (Adaptée de Smiths et 
al. 2020) et D) les gastéropodes, incluant la longueur de la coquille (SL = Shell Length) (Figure 
adaptée de Cob et al. 2008). 

A B 

C D 
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1. Utiliser deux points 3D pour effectuer les mesures (linéaires) de taille des différents 

organismes présents en s’assurant que l’individu soit en position optimale. 
a. Cliquer sur une extrémité du spécimen sélectionné (clic gauche) sur l’image de 

gauche. Une croix et une ligne épipolaire jaune apparaissent sur l’image de droite. 
b. Suivre la ligne épipolaire afin de repérer la position correspondant au même point sur 

l’organisme dans l’image de droite.  
c. Répéter ces deux étapes afin d’identifier la seconde extrémité du spécimen à mesurer, 

tel que présenté à la Figure A2. (Note : si un avertissement concernant les règles de 
mesures stéréoscopiques apparaît lors de la prise de mesure (Figure A2.23), cliquer 
sur Non, effacer et reprendre la mesure). 

 

Figure A2.23. Prise de mesure stéréoscopique, à la fourche (FL = Fork lenght), d’une morue 
Gadus morhua. Longueur (lenght) de 263 mm, réalisée à une distance (Range) de 1,11 m, avec 
une direction horizontale (Horiz. Dir) et verticale (Vert. Dir.) d’environ 1 degré par rapport à l’axe 
des caméras, avec des valeurs de RMS (RMS Intersection 1 et 2) de moins de 10 mm et une 
valeur de précision (moyenne écart-type des coordonnées X, Y, Z) de moins de 1 mm. 
 

 
Figure A2.24. Boîte de dialogue apparaissant comme avertissement lorsque des règles de 
mesures stéréoscopiques ne sont pas respectées (ex. RMS trop élevé et direction horizontale 
supérieure à la limite recommandée). 
 

d. Identifier l’espèce mesurée et inscrire le type de mesure dans l’espace MesureID de 
la fiche de saisie pour les attributs de la mesure qui apparaît avec la boîte de dialogue 
contenant les informations concernant la mesure 3D (Figure A2.23). 

e. Laisser les autres valeurs par défaut. 
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f. Cliquer sur OK pour enregistrer la mesure. 
 
2. Effectuer les mesures de taille de manière opportuniste, pour toutes les espèces, du début à 

la fin de la période d’analyse. 
3. Effectuer un retour au MaxN de chaque taxon afin de maximiser l’effort de mesure.  

a. Sélectionner l’onglet MaxN dans le menu Data view de la table Data EventMeasure et 
double cliquer sur la ligne d’un taxon afin d’être redirigé au moment où le MaxN a été 
atteint. 

b. Mesurer un maximum d’individus présents en balayant les vidéos jusqu’à ce que 
chaque individu soit en position optimale. 

c. Noter le numéro de l’individu et le type de mesure effectué pour chaque cas dans le 
champ MesureID (ex. Cancer irroratus 01_CW et 02_CW), pour assurer la traçabilité 
d’un vidéo à l’autre (Note : attention de ne pas mesurer deux fois le même individu) 
(Figure A2.25). 

 

 
Figure A2.25. Groupe d’individus de Mallotus villosus mesurés au MaxN, avec chaque individu 
identifié par un MesureID comprenant le numéro d’individu et le type de mesure effectué. 
 
Contrôle de la qualité sur les mesures 
 
1. Évaluer la variabilité lorsqu’un spécimen s’avère difficile à mesurer en prenant quelques 

mesures répétitives sur le même individu. 
a. Mesurer le même individu de 3 à 5 fois, à différentes positions dans le champ 

d’analyse. 
b. Cliquer sur Measurements > Measurements summaries > 3D > Average Length 

measurements. 
c. Noter la moyenne et l’écart-type standard (SD) et si la variabilité s’avère trop 

importante, rejeter les mesures (Note : Si d’autres écarts importants sont notés, il y a 
peut-être un problème dans l’alignement des caméras ou avec les fichiers de 
calibration; noter le problème en commentaires et aviser la personne responsable des 
analyses). 

 
Comportement 
 
Au cours des déploiements, il est possible d’observer des interactions ou des comportements 
avérés. Bien que les individus se verront attribuer le paramètre d’activité par défaut « Passing », 
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au moment d’entrer dans le champ d’analyse d’EventMeasure, les comportements évidents 
observés de manière opportuniste en cours d’analyse seront notés en créant un point sur le bras 
d’appât tel que présenté à la Figure A2.26. 
 
1. Marquer le moment d’un comportement observé par un point d’annotation sur la barre de la 

cage à appât. 
2. Inscrire dans le champ Family la valeur « Comportement » et supprimer toutes les autres 

valeurs par défaut. 
3. Débuter avec l’inscription C_ et ajouter ensuite une courte description factuelle du 

comportement observé dans le champ Comment, (p. ex. « C_Hyas attaque Hyas », 
« C_Cottidae chasse Gadus morhua » ou « C_Gadus morhua en alimentation », « C_Hyas 
vs appat CVSA » (Note : ne pas utiliser le champ Activity pour suivre le comportement de 
chaque individu d’une espèce). 

 

 
Figure A2.26. Annotation d’un comportement à un moment où un individu Hyas sp. attaque un 
autre Hyas sp. 
 
2.8 Exportation des données brutes avec EventMeasure 
 
1. Rassembler tous les fichiers .emobs d’une mission dans un dossier commun afin d’exporter 

les données en lot. 
2. Ouvrir un des fichiers EventMeasure .emobs dans le dossier commun et configurer le logiciel 

pour programmer l’exportation des données d’intérêts en lot (Figure A2.27). 
3. À partir de l’interface EventMeasure, cliquer sur Program > Batch text fil output …  et 

compléter les cases ci-dessous.  
a. Input file directory : sélectionner le dossier commun contenant tous les fichiers 

.emobs. 
b. Output file directory : sélectionner le dossier commun qui contiendra toutes les tables 

de données qui seront exportées en lot. 
c. Delimiter : sélectionner le type de séparateur de tabulation Comma (séparateur avec 

virgule). 
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Figure A2.27. Configuration du logiciel EventMeasure, pour l’exportation de certaines tables de 
données d’intérêts (en lot). 
 
4. Sélectionner par la suite les tables de données essentielles. 

a. Point measurements : Inscrire « True » pour programmer l’exportation des données 
de points d’annotation 2D. 

b. Periods : Inscrire « True » pour programmer l’exportation des données des champs 
d’information pour chaque déploiement CVSA (incluant les métadonnées, les données 
d’analyse du substrat et des conditions environnementales initiales) et de durée des 
périodes d’analyse (calculé automatiquement par le logiciel EventMeasure). 

c. 3D point and length measurements : Inscrire « True » pour programmer l’exportation 
des données de points 3D et de mesures de taille. 

d. Sélectionner, si désiré, les tables de données facultatives (toutes ces données 
peuvent être calculées à partir des données des tables essentielles). 

▪ MaxN : Inscrire « True » pour programmer l’exportation des indices 
d’abondance du MaxN, calculé automatiquement par le logiciel EventMeasure. 

▪ Cumulative MaxN : Inscrire « True » pour programmer l’exportation des 
indices d’abondance du MaxN cumulatif dans le temps, calculé 
automatiquement par le logiciel EventMeasure. 

▪ Time first seen : Inscrire « True » pour programmer l’exportation du moment à 
laquelle une espèce a été vue la première fois, calculée automatiquement par 
le logiciel EventMeasure. 
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5. Cliquer sur Process et vérifier que toutes les données sortantes apparaissent dans les fichiers 
.csv. 

a. All Point measurements. 
b. All Periods. 
c. All 3D point and length measurements. 
d. All MaxN. 
e. All Cumulative MaxN. 
f. All Time first seen. 

 


